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Newton’s Third Law 
You may have learned this statement of Newton’s third law: “To every action there is an equal 
and opposite reaction.” What does this sentence mean? This experiment will help you investigate 
this question. 

Unlike Newton’s first two laws of motion, which concern only individual objects, the third law 
describes an interaction between two bodies. For example, what if you pull on your partner’s hand 
with your hand? To study this interaction, you can use two Force Sensors. As one object (your 
hand) pushes or pulls on another object (your partner’s hand), the Force Sensors will record those 
pushes and pulls. They will be related in a very simple way as predicted by Newton’s third law. 

The action referred to in the phrase above is the force applied by your hand, and the reaction is 
the force that is applied by your partner’s hand. Together, they are known as a force pair. This 
short experiment will show how the forces are related. 
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Figure 1 

 
 
OBJECTIVES 

• Observe the directional relationship between force pairs.  
• Observe the time variation of force pairs. 
• Explain Newton’s third law in simple language.  

 
 
MATERIALS 

LabQuest 500 g mass 
LabQuest App string 
two Vernier Dual-Range Force Sensors  rubber band 
   or two Wireless Dynamics Sensor Systems (WDSS)  

 
 
PRELIMINARY QUESTIONS 
Answer these questions as best you can. You will have a chance to revisit your answers after the 
activity. 
1. You are driving down the highway and a bug splatters on your windshield. Which is greater: 

the force of the bug on the windshield or the force of the windshield on the bug?  
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2. Hold a rubber band between your right and left hands. Pull with your left hand. Does your 
right hand experience a force? Does your right hand apply a force to the rubber band? What 
direction is that force compared to the force applied by the left hand? 

3. Pull harder with your left hand. Does this change any force applied by the right hand? 

4. How is the force of your left hand, transmitted by the rubber band, related to the force applied 
by your right hand? Write a rule, in words, for the force relationship. 

 
PROCEDURE 
1. Set the range switches of the Dual-Range Force Sensors to 50 N. Connect the two Force 

Sensors to LabQuest. Choose New from the File menu.  

 Force Sensors measure force only along one direction; if you apply a force along another 
direction, your measurements will not be meaningful. The Force Sensor responds to force 
directed parallel to the long axis of the sensor.  

2. (Optional) Because you will be comparing the readings of two different Force Sensors, it is 
important that they both read force accurately. To increase the accuracy of the sensors, you 
will calibrate them. 
a. Choose Calibrate ► CH:1 Force from the Sensors menu. 
b. Hold the sensor attached to Channel 1 so that you can hang a weight from it, but do not 

attach any weight now.  
c. Select Calibrate Now. 
d. Enter 0 (zero) as the known value for Reading 1, and then tap Keep. 
e. Hang a 4.9 N weight (500 g) from the sensor.  
f. Enter 4.9 as the known value for Reading 2 and tap Keep. 
g. Select OK. 
h. Now choose Calibrate ► CH:2 Force from the Sensors menu. Repeat Parts b–g for the 

second Force Sensor. 
 
3. Set up the Force Sensors so they read the same magnitude under the same force, but with 

opposite signs. To do this, you will zero both sensors and then reverse the direction of one of 
them. When you are done, a pull on one sensor produces a positive reading while a pull on the 
other produces a negative reading. 
a. Hold both sensors with the measurement axis horizontal and no force applied to the hooks. 
b. When the readings stabilize, choose Zero ► All Sensors from the Sensors menu. The 

readings for the sensors should be close to zero. 
c. Choose Reverse ► CH:2 Force from the Sensors menu to change the sign. 

 
4. Make a short loop of string with a circumference of about 30 cm. Use it to attach the hooks of 

the Force Sensors. Hold one Force Sensor in your hand and have your partner hold the other 
so you can pull on each other using the string as an intermediary. Be careful to apply force 
only along the sensitive direction of your particular Force Sensor. 

5. Start data collection. Gently tug on your partner’s Force Sensor with your Force Sensor. 
Also, have your partner tug on your sensor. You will have 5 seconds to try different pulls. 
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6. After data collection is complete, the graph of force vs. time will be displayed with data from 
both sensors. If either plot has force peaks with flat tops, you pulled too hard. Try again, 
pulling with less force. To take more data, start data collection again. 

7. Print or sketch your graph. Store the run (Run 1) by tapping the File Cabinet. 

8. What would happen if you used the rubber band instead of the string? Would some of the 
force get “used up” in stretching the band? Sketch a prediction graph of the two force 
readings in your notes, and repeat Steps 5–7 using the rubber band instead of the string.  

 
ANALYSIS 
1. Examine the string data. 

a. Choose Graph Options from the Graph menu and then select to graph only Run 1 on the  
y-axis.  

b. To examine the data on the displayed graph, select any data point. As you move the tap 
each data point, the two force values for a given time are displayed to the right of the 
graph. What can you conclude about the two forces (your pull on your partner and your 
partner’s pull on you)? How are the magnitudes related? How are the signs related?  

 
2. Examine the rubber band data. 

a. Choose Graph Options from the Graph menu and then select to graph only Run 2 on the  
y-axis.  

b. Examine the data on the displayed graph. How does the rubber band change the results—
or does it change them at all? 

 
3. While you and your partner are pulling on each other’s Force Sensors, do your Force Sensors 

have the same positive direction? What impact does your answer have on the analysis of the 
force pair? 

4. Is there any way to pull on your partner’s Force Sensor without your partner’s Force Sensor 
pulling back? Try it. 

5. Reread the statement of the third law given at the beginning of this activity. The phrase equal 
and opposite must be interpreted carefully, since for two vectors to be equal (

 

A B= ) and 
opposite (

 

A B= − ) then we must have 
 

A B= = 0 ; that is, both forces are always zero. What is 
really meant by equal and opposite? Restate Newton’s third law in your own words, not using 
the words “action,” “reaction,” or “equal and opposite.” 

6. Re-evaluate your answers to the preliminary questions.  

 
EXTENSIONS 
1. Fasten one Force Sensor to your lab bench and repeat the experiments. Does the bench pull 

back as you pull on it? Does it matter that the second Force Sensor is not held by a person?  

2. Use a rigid rod to connect your Force Sensors instead of a string and experiment with mutual 
pushes instead of pulls. Repeat the experiments. Does the rod change the way the force pairs 
are related? 
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Computer5
Picket Fence Free Fall

We say an object is in free fall when the only force acting on it is the Earth’s gravitational force.
No other forces can be acting; in particular, air resistance must be either absent or so small as to
be ignored. When the object in free fall is near the surface of the Earth, the gravitational force on
it is nearly constant. As a result, an object in free fall accelerates downward at a constant rate.
This acceleration is usually represented with the symbol, g.

Physics students measure the acceleration due to gravity using a wide variety of timing methods.
In this experiment, you will have the advantage of using a very precise timer and a Photogate.
The Photogate has a beam of infrared light that travels from one side to the other. It can detect
whenever this beam is blocked. You will drop a piece of clear plastic with evenly spaced black
bars on it, called a Picket Fence. As the Picket Fence passes through the Photogate, the interface
measures the time from the leading edge of one bar blocking the beam until the leading edge of
the next bar blocks the beam. This timing continues as all eight bars pass through the Photogate.
From these measured times, the software calculates and plots the velocities and accelerations for
this motion.

Figure 1

OBJECTIVE
l Measure the acceleration of a freely falling body, g, to better than 0.5% precision using a
Picket Fence and a Photogate.



Experiment 5

MATERIALS
computer
Vernier computer interface
Logger Pro
Vernier Photogate
Picket Fence
clamp or ring stand to secure Photogate

PRELIMINARY QUESTIONS
1. Inspect your Picket Fence. You will be dropping it through a Photogate to measure g. The

distance, measured from one edge of a black band to the same edge of the next band, is
5.0 cm. What additional information is needed to determine the average speed of the Picket
Fence as it moves through the Photogate?

2. If an object is moving with constant acceleration, what is the shape of its velocity vs. time
graph?

3. Does the initial velocity of an object have anything to do with its acceleration? For example,
compared to dropping an object, if you throw it downward would the acceleration be
different after you released it?

PROCEDURE
1. Fasten the Photogate rigidly to a ring stand so the arms extend horizontally, as shown in

Figure 1. The entire length of the Picket Fence must be able to fall freely through the
Photogate. To avoid damaging the Picket Fence, provide a soft landing surface (such as
carpet).

2. Connect the Photogate to the digital (DIG) port of the Vernier computer interface.

3. Open the file “05 Picket Fence Free Fall” in the Physics with Vernier folder.

4. Observe the reading in the status bar of Logger Pro at the top of the screen. Block the
Photogate with your hand; note that the GateState is shown as Blocked. Remove your hand
and the display will change to Unblocked.

5. Click to prepare the Photogate for data collection. Hold the top of the Picket Fence
between two fingers, allowing the Picket Fence to hang freely just above the center of the
Photogate, without blocking the gate. Release the Picket Fence so it leaves your grasp
completely before it enters the Photogate. The Picket Fence must remain vertical and should
not touch the Photogate as it falls.

6. Examine your graphs. The slope of a velocity vs. time graph is a measure of acceleration. If
the velocity graph is approximately a straight line of constant slope, the acceleration is
constant. If the acceleration of your Picket Fence appears constant, fit a straight line to your
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data. To do this, click the velocity graph once to select it, then click Linear Fit, , to fit the
line, y = mt + b, to the data. Record the slope in the data table.

7. To establish the reliability of your slope measurement, repeat Steps 5 and 6 five more times.
Do not use drops in which the Picket Fence hits or misses the Photogate. Record the slope
values in the data table.

DATA TABLE
Trial 1 2 3 4 5 6

Slope (m/s2)

Minimum Maximum Average

Acceleration (m/s2)

Acceleration due to gravity, g ±                   m/s2

Precision %

ANALYSIS
1. From your six trials, determine the minimum, maximum, and average values for the

acceleration of the Picket Fence. Record them in the data table.

2. Describe in words the shape of the position vs. time graph for the free fall.

3. Describe in words the shape of the velocity vs. time graph. How is this related to the shape of
the position vs. time graph?

4. The average acceleration you determined represents a single best value, derived from all your
measurements. The minimum and maximum values give an indication of how much the
measurements can vary from trial to trial; that is, they indicate the precision of your
measurement. One way of stating the precision is to take half of the difference between the
minimum and maximum values and use the result as the uncertainty of the measurement.
Express your final experimental result as the average value, ± the uncertainty. Round the
uncertainty to just one digit and round the average value to the same decimal place.

For example, if your minimum, average, and maximum values are 9.12, 9.93, and 10.84 m/s2,
express your result as g = 9.9 ± 0.9 m/s2. Record your values in the data table.
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5. Express the uncertainty as a percentage of the acceleration. This is the precision of your
experiment. Enter the value in your data table. Using the example numbers from the last step,
the precision would be

× 100% = 9%
0.9

9.9

6. Compare your measurement to the generally accepted value of g (from a textbook or other
source). Does the accepted value fall within the range of your values? If so, your experiment
agrees with the accepted value.

7. Inspect your velocity graph. How would the associated acceleration vs. time graph look?
Sketch your prediction on paper. Now change the upper graph to acceleration vs. time. To do
this, click the y-axis label and select Acceleration. Comment on any differences. You may
want to rescale the graph so that the acceleration axis begins at zero.

8. Use the Statistics tool and the acceleration graph to find the average acceleration. How does
this compare with the acceleration value for the same drop, determined from the slope of the
velocity graph?

EXTENSIONS
1. Use the position vs. time graph and a parabolic fit to determine g.

2. Would dropping the Picket Fence from higher above the Photogate change any of the
parameters you measured? Try it.

3. Would throwing the Picket Fence downward, but letting go before it enters the Photogate,
change any of your measurements? How about throwing the Picket Fence upward? Try
performing these experiments.

4. How would adding air resistance change the results? Try adding a loop of clear tape to the
upper end of the Picket Fence. Drop the modified Picket Fence through the Photogate and
compare the results with your original free-fall results.

5. Investigate how the value of g varies around the world. For example, how does altitude affect
the value of g? What other factors cause this acceleration to vary at different locations? For
example, is g different at high altitudes such as Svalbard, an archipelago north of Norway?

6. Collect g measurements for your entire class, and plot the values in a histogram. Is there a
most common value? Are the measurements consistent with one another?

5 - 4 Physics with Vernier



Physics with Vernier © Vernier Software & Technology 5 - 1

LabQuest5
Picket Fence Free Fall

We say an object is in free fall when the only force acting on it is the Earth’s gravitational force.
No other forces can be acting; in particular, air resistance must be either absent or so small as to
be ignored. When the object in free fall is near the surface of the Earth, the gravitational force on
it is nearly constant. As a result, an object in free fall accelerates downward at a constant rate.
This acceleration is usually represented with the symbol, g.

Physics students measure the acceleration due to gravity using a wide variety of timing methods.
In this experiment, you will have the advantage of using a very precise timer and a Photogate.
The Photogate has a beam of infrared light that travels from one side to the other. It can detect
whenever this beam is blocked. You will drop a piece of clear plastic with evenly spaced black
bars on it, called a Picket Fence. As the Picket Fence passes through the Photogate, the interface
measures the time from the leading edge of one bar blocking the beam until the leading edge of
the next bar blocks the beam. This timing continues as all eight bars pass through the Photogate.
From these measured times, the software calculates and plots the velocities and accelerations for
this motion.

Figure 1

OBJECTIVE
l Measure the acceleration of a freely falling body, g, to better than 0.5% precision using a
Picket Fence and a Photogate.
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MATERIALS
LabQuest
LabQuest App
Vernier Photogate
Picket Fence
clamp or ring stand to secure Photogate

PRELIMINARY QUESTIONS
1. Inspect your Picket Fence. You will be dropping it through a Photogate to measure g. The

distance, measured from one edge of a black band to the same edge of the next band, is
5.0 cm. What additional information is needed to determine the average speed of the Picket
Fence as it moves through the Photogate?

2. If an object is moving with constant acceleration, what is the shape of its velocity vs. time
graph?

3. Does the initial velocity of an object have anything to do with its acceleration? For example,
compared to dropping an object, if you throw it downward would the acceleration be
different after you released it?

PROCEDURE
1. Fasten the Photogate rigidly to a ring stand so the arms extend horizontally, as shown in

Figure 1. The entire length of the Picket Fence must be able to fall freely through the
Photogate. To avoid damaging the Picket Fence, provide a soft landing surface (such as a
carpet).

2. Connect the Photogate to the digital (DIG) port of LabQuest and choose New from the File
menu.

3. Observe the reading on the Meter screen. Block the Photogate with your hand; note that the
Gate State is shown as Blocked. Remove your hand and the display will change to
Unblocked.

4. Start data collection to prepare the Photogate to collect data. Note: Data are collected when
the gate is blocked for the first time after data collection is started.

5. Hold the top of the Picket Fence between two fingers, allowing the Picket Fence to hang
freely just above the center of the Photogate, without blocking the gate. Release the Picket
Fence so it leaves your grasp completely before it enters the Photogate. The Picket Fence
must remain vertical and should not touch the Photogate as it falls.

6. When the Picket Fence has completely passed through the Photogate, a graph of position vs.
time and velocity vs. time appears on the screen. Sketch the graphs on paper for later use.

7. Examine your velocity vs. time graph. The slope of a velocity vs. time graph is a measure of
acceleration. If the velocity graph is approximately a straight line of constant slope, the
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acceleration is constant. If the acceleration of your Picket Fence appears constant, fit a straight
line to your data.
a. Choose Curve Fit from the Analyze menu.
b. Select Linear as the Fit Equation.
c. Record the slope of the linear curve fit in the data table.
d. Select OK.

8. To establish the reliability of your slope measurement, repeat Steps 4–7 five more times. Do
not use drops in which the Picket Fence hits or misses the Photogate. Record the slope values
in the data table.

DATA TABLE
Trial 1 2 3 4 5 6

Slope (m/s2)

Minimum Maximum Average

Acceleration (m/s2)

Acceleration due to gravity, g ±                   m/s2

Precision %

ANALYSIS
1. From your six trials, determine the minimum, maximum, and average values for the

acceleration of the Picket Fence. Record them in the data table.

2. Describe in words the shape of the position vs. time graph for the free fall.

3. Describe in words the shape of the velocity vs. time graph. How is this related to the shape of
the position vs. time graph?

4. The average acceleration you determined represents a single best value, derived from all your
measurements. The minimum and maximum values give an indication of how much the
measurements can vary from trial to trial; that is, they indicate the precision of your
measurement. One way of stating the precision is to take half of the difference between the
minimum and maximum values and use the result as the uncertainty of the measurement.
Express your final experimental result as the average value, ± the uncertainty. Round the
uncertainty to just one digit and round the average value to the same decimal place.

For example, if your minimum, average, and maximum values are 9.12, 9.93, and 10.84
m/s2, express your result as g = 9.9 ± 0.9 m/s2. Record your values in the data table.
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5. Express the uncertainty as a percentage of the acceleration. This is the precision of your
experiment. Enter the value in your data table. Using the example numbers from the last step,
the precision would be

× 100% = 9%
0.9

9.9

6. Compare your measurement to the generally accepted value of g (from a textbook or other
source). Does the accepted value fall within the range of your values? If so, your experiment
agrees with the accepted value.

7. Inspect your velocity graph. How would the associated acceleration vs. time graph look?
Sketch your prediction on paper. Change the y-axis to acceleration. Comment on any
differences between the acceleration graph and your prediction. To examine the data pairs on
the displayed graph, tap any data point. As you tap each data point, the acceleration and time
values are displayed to the right of the graph. Note that the vertical scale of the graph does not
include zero. Is the variation as large as it appears?

8. Use the Statistics tool and the acceleration graph to find the average acceleration. How does
this compare with the acceleration value for the same drop, determined from the slope of the
velocity graph?

EXTENSIONS
1. Use the position vs. time data and a quadratic fit to determine g.

2. Would dropping the Picket Fence from higher above the Photogate change any of the
parameters you measured? Try it.

3. Would throwing the Picket Fence downward, but letting go before it enters the Photogate,
change any of your measurements? How about throwing the Picket Fence upward? Try
performing these experiments.

4. How would adding air resistance change the results? Try adding a loop of clear tape to the
upper end of the Picket Fence. Drop the modified Picket Fence through the Photogate and
compare the results with your original free-fall results.

5. Investigate how the value of g varies around the world. For example, how does altitude affect
the value of g? What other factors cause this acceleration to vary at different locations? For
example, is g different at high altitudes such as Svalbard, an archipelago north of Norway?

6. Collect g measurements for your entire class, and plot the values in a histogram. Is there a
most common value? Are the measurements consistent with one another?
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Computer24
Capacitors

The charge q on a capacitor’s plate is proportional to the potential difference V across the
capacitor. We express this relationship with

where C is a proportionality constant known as the capacitance. C is measured in the unit of the
farad, F, (1 farad = 1 coulomb/volt).

If a capacitor of capacitance C (in farads), initially charged to a potential V
0
(volts) is connected

across a resistor R (in ohms), a time-dependent current will flow according to Ohm’s law. This
situation is shown by the RC (resistor-capacitor) circuit below when the switch is connecting
terminals 33 and 34.

Figure 1
As the charge flows, the charge q on the capacitor is depleted, reducing the potential across the
capacitor, which in turn reduces the current. This process creates an exponentially decreasing
current, modeled by

The rate of the decrease is determined by the product RC, known as the time constant of the
circuit. A large time constant means that the capacitor will discharge slowly.

In contrast, when the capacitor is charged, the potential across it approaches the final value
exponentially, modeled by

The same time constant, RC, describes the rate of charging as well as discharging.



Experiment 24

OBJECTIVES
l Measure an experimental time constant of a resistor-capacitor circuit.
l Compare the time constant to the value predicted from the component values of the
resistance and capacitance.

l Measure the potential across a capacitor as a function of time as it discharges and as it
charges.

l Fit an exponential function to the data. One of the fit parameters corresponds to an
experimental time constant.

MATERIALS
computer
Vernier computer interface
Logger Pro
Vernier Differential Voltage Probe
connecting wires with clips
Vernier Circuit Board 2 with batteries or
10 μF non-polarized capacitor
100 kΩ and 47 kΩ resistors
two C- or D-cell batteries with holder
single-pole, double-throw switch

PRELIMINARY QUESTIONS
1. Consider a candy jar, initially with 1000 candies. You walk past it once each hour. Since you

do not want anyone to notice that you are taking candy, each time you take only 10% of the
candies remaining in the jar. Sketch a graph of the number of candies for a few hours.

2. How would the graph change if instead of removing 10% of the candies, you removed 20%?
Sketch your new graph.

PROCEDURE
1. Set up the equipment.

a. Connect the circuit using the 10 μF capacitor and the 100 kΩ resistor, as shown in
Figure 1. Note: The numbers in the figure refer to the numbered terminals on the Vernier
Circuit Board.

b. Record the values of your resistor and capacitor in your data table, as well as any
tolerance values marked on them.

c. Connect the Differential Voltage Probe to the computer interface.
d. Connect the clip leads on the Differential Voltage Probe across the capacitor.

Note: Connect the red lead to the side of the capacitor connected to the resistor. Connect
the black lead to the other side of the capacitor.
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e. Set Switch 1, SW1, located below the battery holder on the Vernier Circuit Board, to
3.0 V.

2. Open the file in the “24 Capacitors” file in the Physics with Vernier folder.

3. Set Switch 2, SW2, to charge the capacitor for 10 seconds (so the switch is closer to
terminal 32). Watch the voltage reading to see if the potential is still increasing.

4. Click to begin data collection. As soon as graphing starts, flip Switch 2 to discharge
the capacitor. Your data shows a constant value initially, then a decreasing function.

5. To compare your data to the model, select only the data after the potential has started to
decrease by clicking and dragging across the curved portion of the graph; that is, omit the
constant portions on either end of the discharge cycle. Click Curve Fit, , and from the
function selection box, choose the Natural Exponent function, A*exp(–Ct) + B. Click ,
and inspect the fit. Click .

6. Record the value of the fit parameters in your data table. Notice that the C used in the curve
fit is not the same as the C representing capacitance. Compare the fit equation to the
mathematical model for a capacitor discharge proposed in the introduction.

How is fit constant C related to the time constant of the circuit, which was defined in the
introduction?

7. Print or sketch the graph of potential vs. time. Choose Store Latest Run from the Experiment
menu to store your data. You will need the data for later analysis.

8. The capacitor is now discharged. To monitor the charging process, click . As soon as
data collection begins, change Switch 2 so the capacitor charges. Allow data collection to run
to completion.

9. This time you will compare your data to the mathematical model for a capacitor charging,

Select the data beginning after the potential has started to increase, omitting portions on either
end of the charge cycle. Click Curve Fit, , and from the function selection box, choose the
Inverse Exponent function, A*(1–exp(–Ct))+B. Check the time offset curve fit box. Click

and inspect the fit. Click to return to the main graph.

10. Record the value of the fit parameters in your data table. Compare the fit equation to the
mathematical model for a charging capacitor.
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11. Hide your first runs by choosing Hide Data Set from the Data menu. Remove any remaining
fit information by clicking the upper left corner in the floating boxes.

12. Now you will repeat the experiment with a resistor of lower value. How do you think this
change will affect the way the capacitor discharges? Rebuild your circuit using the 47 kΩ
resistor and repeat Steps 3–10.

DATA TABLE
Fit parameters Resistor Capacitor Time

constant

Trial A B C 1/C R
(Ω)

C
(F)

RC
(s)

Discharge 1

Charge 1

Discharge 2

Charge 2

ANALYSIS
1. In the data table, calculate the time constant of the circuit used; that is, the product of

resistance in ohms and capacitance in farads. Note: 1Ω F = 1 s

2. Calculate and enter in the data table the inverse of the fit constant C for each trial. Now
compare each of these values to the time constant of your circuit. How is the fit parameter A
related to your experiment?

3. Resistors and capacitors are not marked with their exact values, but only approximate values
with a tolerance. Determine the tolerance of the resistors and capacitors you are using. If there
is a discrepancy between the two quantities compared in Question 2, can the tolerance values
explain the difference?

4. What was the effect of reducing the resistance of the resistor on the way the capacitor
discharged?

5. How would the graphs of your discharge graph look if you plotted the natural logarithm of
the potential across the capacitor vs. time? Sketch a prediction. Show Run 1 (the first
discharge of the capacitor) and hide the remaining runs. Click the y-axis label Select ln(V).

6. What is the significance of the slope of the plot of ln(V) vs. time for a capacitor discharge
circuit?
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EXTENSIONS
1. What fraction of the initial potential remains after one time constant has passed? After two

time constants? Three?

2. Instead of a resistor, use a small flashlight bulb. To light the bulb for a perceptible time, use a
large capacitor (approximately 1 F). Collect data. Explain the shape of the graph.

3. Try different value resistors and capacitors and see how the capacitor discharge curves
change.

4. Try two 10 μF capacitors in parallel. Predict what happens to the time constant. Repeat the
discharge measurement and determine the time constant of the new circuit using a curve fit.

5. Try two 10 µF capacitors in series. Predict what will happen to the time constant. Repeat the
discharge measurement and determine the time constant for the new circuit using a curve fit.

Physics with Vernier 24 - 5
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LabQuest24
Capacitors

The charge q on a capacitor’s plate is proportional to the potential difference V across the
capacitor. We express this relationship with

where C is a proportionality constant known as the capacitance. C is measured in the unit of the
farad, F, (1 farad = 1 coulomb/volt).

If a capacitor of capacitance C (in farads), initially charged to a potential V
0
(volts) is connected

across a resistor R (in ohms), a time-dependent current will flow according to Ohm’s law. This
situation is shown by the RC (resistor-capacitor) circuit below when the switch is connecting
terminals 33 and 34.

Figure 1
As the charge flows, the charge q on the capacitor is depleted, reducing the potential across the
capacitor, which in turn reduces the current. This process creates an exponentially decreasing
current, modeled by

The rate of the decrease is determined by the product RC, known as the time constant of the
circuit. A large time constant means that the capacitor will discharge slowly.

OBJECTIVES
l Measure an experimental time constant of a resistor-capacitor circuit.
l Compare the time constant to the value predicted from the component values of the
resistance and capacitance.

l Measure the potential across a capacitor as a function of time as it discharges.
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l Fit an exponential function to the data. One of the fit parameters corresponds to an
experimental time constant.

MATERIALS
LabQuest
LabQuest App
Vernier Differential Voltage Probe
connecting wires with clips
Vernier Circuit Board 2 with batteries or
10 μF non-polarized capacitor
100 kΩ and 47 kΩ resistors
two C- or D-cell batteries with holder
single-pole, double-throw switch

PRELIMINARY QUESTIONS
1. Consider a candy jar, initially with 1000 candies. You walk past it once each hour. Since you

do not want anyone to notice that you are taking candy, each time you take only 10% of the
candies remaining in the jar. Sketch a graph of the number of candies for a few hours.

2. How would the graph change if instead of removing 10% of the candies, you removed 20%?
Sketch your new graph.

PROCEDURE
1. Set up the equipment.

a. Connect the circuit using the 10 μF capacitor and the 100 kΩ resistor, as shown in
Figure 1. Note: The numbers in the figure refer to the numbered terminals on the Vernier
Circuit Board.

b. Record the values of your resistor and capacitor in your data table, as well as any
tolerance values marked on them.

c. Connect the Differential Voltage Probe to LabQuest and choose New from the File
menu.

d. Connect the clip leads on the Differential Voltage Probe across the capacitor.
Note: Connect the red lead to the side of the capacitor connected to the resistor. Connect
the black lead to the other side of the capacitor.

e. Set Switch 1, SW1, located below the battery holder on the Vernier Circuit Board, to
3.0 V.

2. Monitor the input to determine the maximum voltage your battery produces.
a. Set Switch 2, SW2, to charge the capacitor for 10 seconds (so the switch is closer to

terminal 32).
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b. Watch the reading on the screen and record the maximum value reached. You will use
this value in the next step.

3. Set up LabQuest for triggering and data collection. In this mode you will not have to
manually synchronize data collection and the capacitor discharge. Instead, LabQuest will wait
for the voltage to reach a certain level before collecting data.
a. On the Meter screen, tap Rate. Change the data-collection rate to 200 samples/second and

the data-collection duration to 4 seconds.
b. Tap Triggering and select Enable Triggering.
c. Change the Triggering settings so that data collection starts when voltage is decreasing.
d. Enter a trigger level of 90% of the maximum voltage you observed in Step 2. This means

that data collection will begin when voltage decreases across this trigger level.
e. Use 0 as the number of points collected before data collection is triggered.
f. Select OK.

4. Collect data.
a. Start data collection.
b. Flip Switch 2 to discharge the capacitor.
c. LabQuest waits for the measured voltage to reach the trigger level before collecting data.

After data collection is complete, a graph of voltage vs. time is displayed.

5. Fit the exponential function, y = A * exp(–Cx) + B, to your data.
a. Tap and drag to select only the data after the potential has started to decrease; that is, omit

the constant portions on either end of the discharge cycle.
b. Choose Curve Fit from the Analyze menu.
c. Select Natural Exponent as the Fit Equation.
d. Record the value of the fit parameters in your data table. Notice that the C used in the

curve fit is not the same as the C representing capacitance. Compare the fit equation to the
mathematical model for a capacitor discharge proposed in the introduction.

How is fit constant C related to the time constant of the circuit, which was defined in the
introduction?

e. Select OK.

6. Print or sketch the graph of voltage vs. time.

7. Replace the 100 kΩ resistor with a 47 kΩ resistor in the circuit and repeat Steps 2–6.
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DATA TABLE
Fit parameters Resistor Capacitor Time

constant

Trial A B C 1/C R
(Ω)

C
(F)

RC
(s)

Discharge 1

Discharge 2

ANALYSIS
1. In the data table, calculate the time constant of the circuit used; that is, the product of

resistance in ohms and capacitance in farads. Note: 1Ω F = 1 s

2. Calculate and enter in the data table the inverse of the fit constant C for each trial. Now
compare each of these values to the time constant of your circuit. How is the fit parameter A
related to your experiment?

3. Resistors and capacitors are not marked with their exact values, but only approximate values
with a tolerance. Determine the tolerance of the resistors and capacitors you are using. If there
is a discrepancy between the two quantities compared in Question 2, can the tolerance values
explain the difference?

4. What was the effect of reducing the resistance of the resistor on the way the capacitor
discharged?

EXTENSIONS
1. What fraction of the initial potential remains after one time constant has passed? After two

time constants? Three?

2. Instead of a resistor, use a small flashlight bulb. To light the bulb for a perceptible time, use a
large capacitor (approximately 1 F). Collect data. Explain the shape of the graph.

3. Try different value resistors and capacitors and see how the capacitor discharge curves
change.

4. Try two 10 μF capacitors in parallel. Predict what happens to the time constant. Repeat the
discharge measurement and determine the time constant of the new circuit using a curve fit.

5. Try two 10 µF capacitors in series. Predict what will happen to the time constant. Repeat the
discharge measurement and determine the time constant for the new circuit using a curve fit.

6. Make a plot of ln(V) vs. time for the capacitor discharge. What is the meaning of the slope of
this plot? How is it related to the RC constant?
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Computer3A
Cart on a Ramp
(Motion Encoder)

This experiment uses an incline and a low-friction cart. If you give the cart a gentle push up the
incline, the cart will roll upward, slow and stop, and then roll back down, speeding up. A graph
of its velocity vs. time would show these changes. Is there a mathematical pattern to the changes
in velocity? What is the accompanying pattern to the position vs. time graph? What does the
acceleration vs. time graph look like? Is the acceleration constant?

In this experiment, you will use a Motion Encoder System to collect position, velocity, and
acceleration data for a cart rolling up and down an incline. Analysis of the graphs of this motion
will answer these questions.

Figure 1

OBJECTIVES
l Collect position, velocity, and acceleration data as a cart rolls freely up and down an
incline.

l Analyze position vs. time, velocity vs. time, and acceleration vs. time graphs.
l Determine the best fit equations for the position vs. time and velocity vs. time graphs.
l Determine the mean acceleration from the acceleration vs. time graph.

MATERIALS
computer
Vernier computer interface
Logger Pro
Motion Encoder Receiver
Vernier Dynamics Track
Adjustable End Stop
Vernier Motion Encoder Cart with plunger
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PRELIMINARY QUESTIONS
1. Consider the changes in motion a Dynamics Cart will undergo as it rolls up and down an

incline. Make a sketch of your prediction for the position vs. time graph. Describe in words
what this graph means.

2. Make a sketch of your prediction for the velocity vs. time graph. Describe in words what this
graph means.

3. Make a sketch of your prediction for the acceleration vs. time graph. Describe in words what
this graph means.

PROCEDURE
Part I
1. Connect the Motion Encoder Receiver to the digital (DIG) port of the interface.

2. Confirm that your Dynamics Track, Adjustable End Stop, and Motion Encoder Receiver are
assembled as shown in Figure 1.

3. Open the file “03 Cart on a Ramp” from the Physics with Vernier folder.

4. Place the cart on the track near the end stop. Face the transmitter end of the cart toward the
receiver at the end of the track. Click to begin data collection1 . Wait about a second,
then briefly push the cart up the incline, letting it roll freely up nearly to the top, and then
back down. Catch the cart as it nears the end stop.

5. Select the position vs. time graph by clicking on it and choose Autoscale from the Analyze
menu to see all the position data on the graph. Examine the position vs. time graph.

6. Answer the Analysis questions for Part I before proceeding to Part II.

Part II
7. Your cart can bounce against the end stop with its plunger. Practice starting the cart so it

bounces at least twice during data collection.

8. Collect another set of data showing two or more bounces.

9. Proceed to the Analysis questions for Part II.

1 Logger Pro tip: If a graph is currently selected, you can start data collection by tapping the Space bar.
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ANALYSIS
Part I
1. Either print or sketch the three motion graphs. The graphs you have recorded are fairly

complex, and it is important to identify different regions of each graph. Click Examine, ,
and move the mouse across any graph to answer the following questions. Record your
answers directly on the printed or sketched graphs.
a. Identify the region when the cart was being pushed by your hand:

l Examine the velocity vs. time graph and identify this region. Label this on the
graph.

l Examine the acceleration vs. time graph and identify the same region. Label the
graph.

b. Identify the region where the cart was rolling freely:
l Label the region on each graph where the cart was rolling freely and moving up the
incline.

l Label the region on each graph where the cart was rolling freely and moving down
the incline.

c. Determine the position, velocity, and acceleration at specific points:
l On the velocity vs. time graph, decide where the cart had its maximum velocity, just
as the cart was released. Mark the spot and record the value on the graph.

l On the position vs. time graph, locate the highest point of the cart on the incline.
This point is the closest approach to the Motion Encoder Receiver. Mark the spot
and record the value on the graph.

l What was the velocity of the cart at the top of its motion?
l What was the acceleration of the cart at the top of its motion?

2. The motion of an object in constant acceleration is modeled by x = ½ at2 + v0t + x0, where x
is the position, a is the acceleration, t is time, and v0 is the initial velocity. This is a quadratic
equation whose graph is a parabola. If the cart moved with constant acceleration while it was
rolling, your graph of position vs. time will be parabolic. Fit a quadratic equation to your data.
a. Click and drag the mouse across the portion of the position vs. time graph that is

parabolic, highlighting the free-rolling portion.
b. Click Curve Fit, , select Quadratic fit from the list of models and click .
c. Examine the fit of the curve to your data and click to return to the main graph.
Is the cart’s acceleration constant during the free-rolling segment?

3. The graph of velocity vs. time is linear if the acceleration is constant. To fit a line to this data,
click and drag the mouse across the free rolling region of the motion. Click Linear Fit, .
How closely does the slope correspond to the acceleration you found in the previous step?

4. The graph of acceleration vs. time should appear approximately constant during the freely-
rolling segment. Click and drag the mouse across the free-rolling portion of the motion and
click Statistics, . How closely does the mean acceleration value compare to the values of a
found in Steps 2 and 3?
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Part II
5. Determine the cart’s acceleration during the free-rolling segments using the velocity graph.

Are they the same?

6. Determine the cart’s acceleration during the free-rolling segments using the position graph.
Are they the same?

EXTENSIONS
1. Adjust the angle of the incline to change the acceleration and measure the new value. How

closely does the coefficient of the t2 term in the curve fit compare to ½ g sin θ, where θ is the
angle of the track with respect to horizontal? For a trigonometric method for determining θ,
see the experiment, "Determining g on an Incline," in this book.

2. Compare your results in this experiment with other measurements of g. For example, use the
experiment, "Picket Fence Free Fall," in this book.

3. Use a free-body diagram to analyze the forces on a rolling cart. Predict the acceleration as a
function of incline angle and compare your prediction to your experimental results.

4. Even though the cart has very low friction, the friction is not zero. From your velocity graph,
devise a way to measure the difference in acceleration between the roll up and the roll down.
Can you use this information to determine the friction force in newtons?

5. Use the modeling feature of Logger Pro to superimpose a linear model on the velocity graph.
To insert a model, choose Model from the Analyze menu. Select the linear function and click

. On the Model window, click the slope or intercept label and adjust using the cursor
keys or by typing in new values until you get a good fit. Interpret the slope you obtain.
Interpret the y-intercept.
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LabQuest3A
Cart on a Ramp
(Motion Encoder)

This experiment uses an incline and a low-friction cart. If you give the cart a gentle push up the
incline, the cart will roll upward, slow and stop, and then roll back down, speeding up. A graph
of its velocity vs. time would show these changes. Is there a mathematical pattern to the changes
in velocity? What is the accompanying pattern to the position vs. time graph? What does the
acceleration vs. time graph look like? Is the acceleration constant?

In this experiment, you will use a Motion Encoder System to collect position, velocity, and
acceleration data for a cart rolling up and down an incline. Analysis of the graphs of this motion
will answer these questions.

Figure 1

OBJECTIVES
l Collect position, velocity, and acceleration data as a cart rolls freely up and down an
incline.

l Analyze position vs. time, velocity vs. time, and acceleration vs. time graphs.
l Determine the best fit equations for the position vs. time and velocity vs. time graphs.
l Determine the mean acceleration from the acceleration vs. time graph.

MATERIALS
LabQuest
LabQuest App
Motion Encoder Receiver
Vernier Dynamics Track
Adjustable End Stop
Vernier Motion Encoder Cart with plunger
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PRELIMINARY QUESTIONS
1. Consider the changes in motion a Dynamics Cart will undergo as it rolls up and down an

incline. Make a sketch of your prediction for the position vs. time graph. Describe in words
what this graph means.

2. Make a sketch of your prediction for the velocity vs. time graph. Describe in words what this
graph means.

3. Make a sketch of your prediction for the acceleration vs. time graph. Describe in words what
this graph means.

PROCEDURE
Part I
1. Attach the Motion Encoder Receiver to the track, as shown in Figure 1.

2. Connect the Motion Encoder Receiver to a digital (DIG) port on LabQuest and choose New
from the File menu.

3. Place the cart on the track near the Adjustable End Stop. Face the transmitter end of the cart
toward the receiver at the end of the track. Start data collection. Wait about a second, then
briefly push the cart up the incline, letting it roll freely up nearly to the top, and then back
down. Catch the cart as it nears the end stop.

4. Examine the position vs. time graph. Repeat Step 3 if your position vs. time graph does not
show an area of smoothly changing position. Check with your instructor if you are not sure
whether you need to repeat data collection.

5. Answer the Analysis questions for Part I before proceeding to Part II.

Part II
6. Your cart can bounce against the end stop with its plunger. Practice starting the cart so it

bounces at least two times during data collection.

7. Collect another set of data showing two or more bounces.

8. Proceed to the Analysis questions for Part II.

ANALYSIS
Part I
1. Either print or sketch the three motion graphs. To view the acceleration vs. time graph,

change the y-axis of either graph to Acceleration.
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The graphs you have recorded are fairly complex and it is important to identify different
regions of each graph. Record your answers directly on the printed or sketched graphs.

a. Identify the region when the cart was being pushed by your hand:
l Examine the velocity vs. time graph and identify this region. Label this on the
graph.

l Examine the acceleration vs. time graph and identify the same region. Label the
graph.

b. Identify the region where the cart was rolling freely:
l Label the region on each graph where the cart was rolling freely and moving up the
incline.

l Label the region on each graph where the cart was rolling freely and moving down
the incline.

c. Determine the position, velocity, and acceleration at specific points:
l On the velocity vs. time graph, decide where the cart had its maximum velocity, just
as the cart was released. Mark the spot and record the value on the graph.

l On the position vs. time graph, locate the highest point of the cart on the incline.
This point is the closest approach to the Encoder Receiver. Mark the spot and
record the value on the graph.

l What was the velocity of the cart at the top of its motion?
l What was the acceleration of the cart at the top of its motion?

2. The motion of an object in constant acceleration is modeled by x = ½ at2 + v0t + x0, where x
is the position, a is the acceleration, t is time, and v0 is the initial velocity. This is a quadratic
equation whose graph is a parabola. If the cart moved with constant acceleration while it was
rolling, your graph of position vs. time will be parabolic. To fit a quadratic equation to your
data, you need to first select the data that correspond to the free-rolling segment.

a. Identify the parabolic region of the position graph.
b. Tap and drag your stylus across the region. Choose Zoom In from the Graph menu to

zoom in on just the parabola.
c. Tap and drag across the parabola to select the region.
Now, you can fit a quadratic equation to the selected position vs. time data.

d. Choose Curve Fit ► Position from the Analyze menu.
e. Select Quadratic as the Fit Equation.
f. Record the parameters of the fitted curve (the acceleration) and select OK.
Is the cart’s acceleration constant during the free-rolling segment?
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3. The graph of velocity vs. time is linear if the acceleration is constant. Fit a line to the data.

a. Change the y-axis of the acceleration graph to Velocity.
b. Identify and select the linear region of the graph. Tap and drag across the region to select

the data points.
c. Choose Curve Fit ► Velocity from the Analyze menu. Select Linear as the Fit Equation.
d. Record the slope of the fitted line (the acceleration) and select OK.
How closely does the slope correspond to the acceleration you found in the previous step?

4. Change the y-axis to Acceleration. The graph of acceleration vs. time should appear
approximately constant during the freely-rolling segment.

a. Identify and select the region of the graph that represents when the cart was rolling freely.
b. Tap and drag across the region to select the data points.
c. Choose Statistics ► Acceleration from the Analyze menu.
How closely does the mean acceleration compare to the values of a found in Steps 2 and 3?

Part II
5. Determine the cart’s acceleration during the free-rolling segments using the velocity graph.

Are they the same?

6. Determine the cart’s acceleration during the free-rolling segments using the position graph.
Are they the same?

EXTENSIONS
1. Adjust the angle of the incline to change the acceleration and measure the new value. How

closely does the coefficient of the t2 term in the curve fit compare to ½ g sin θ, where θ is the
angle of the track with respect to horizontal? For a trigonometric method for determining θ,
see the experiment, "Determining g on an Incline," in this book.

2. Compare your results in this experiment with other measurements of g. For example, use the
experiment, "Picket Fence Free Fall," in this book.

3. Use a free-body diagram to analyze the forces on a rolling cart. Predict the acceleration as a
function of incline angle and compare your prediction to your experimental results.

4. Even though the cart has very low friction, the friction is not zero. From your velocity graph,
devise a way to measure the difference in acceleration between the roll up and the roll down.
Can you use this information to determine the friction force in newtons?

5. Use the modeling feature in LabQuest to superimpose a linear model on the velocity graph.
To insert a model, choose Model ► Velocity from the Analyze menu. Select the linear
function, Ax + B. Adjust the slope and intercept values using the up and down arrows or by
typing in new values until you get a good fit. Interpret the slope you obtain. Interpret the y-
intercept.
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Projectile Motion 
You have probably watched a ball roll off a table and strike the floor. What determines where it 
will land? Could you predict where it will land? In this experiment, you will use a projectile 
launcher to fire a ball horizontally. A pair of photogates in the launcher will help you measure the 
initial speed. You will use this information and your knowledge of physics to predict where the 
ball will land when it hits the floor. 

 
Figure 1 

 
 
OBJECTIVES 

• Measure the launch speed of a ball using a Vernier Projectile Launcher. 
• Apply concepts from two-dimensional kinematics to predict the impact point of a ball in 

projectile motion. 
• Take into account trial-to-trial variations in the speed measurement when calculating the 

impact point. 
 
 
MATERIALS 

computer meter stick or metric measuring tape 
Vernier computer interface waxed paper 
Logger Pro steel ball 
Vernier Projectile Launcher Time of Flight Pad (optional, for Extension 
goggles    only) 
level Independence of Motion Accessory (optional, 
plumb bob    for Extension only) 
small cardboard box  
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PRELIMINARY QUESTIONS 
Balance one penny on the edge of a table. Place your index finger on a second penny, then flick 
the second penny so that it travels off the table, while the first penny is gently nudged off the 
edge. It may take a few practice trials to be able to do this effectively. 

 
Figure 2 

 
1. Predict which penny will land first, the penny moving horizontally, or the one that simply 

drops off the table. Explain. 

2. Perform the investigation, listening for the sound of the pennies as they land. Was your 
prediction supported or refuted? 

3. You may believe the pennies landed just a little bit apart from each other. Try it a few more 
times. Does one always land before the other? 

4. What will happen if you increase the speed of the second penny? Predict and then give it a try. 

5. What if you increase the height from which the pennies are dropped? Your instructor may 
choose to stack two tables for you to test this. 

6. Based on your observations, does the horizontal speed of the flicked penny affect the impact 
times of the pennies? 

7. What can you then say about the time to hit the floor for each penny?  

 
INITIAL SET UP 
1. Position the launcher next to the edge of your table. Eventually you will fire a ball horizontally 

that will travel several meters, so plan for this when choosing a location.  

2. Place the level on top of the launch chamber. Use the lower knob on the back of the unit to 
adjust the orientation of the launch chamber until level. Tighten the knob to maintain this 
position. 

3. Next, use the upper knob on the back of the launcher to set the scale to 0˚. Move the scale so 
that the notch of the launcher chamber is at 0˚. This setting accounts for deviation of the 
tabletop from horizontal. 

4. Connect the Projectile Launcher to the interface. To do this, connect the clear, telephone-style 
end of the cable to the “Interface” port on the Projectile Launcher and the white, rectangular 
British Telecom end to the digital (DIG) port of the interface.  
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5. Open the file “08B Projectile Motion (Launcher)” in the Physics with Vernier folder. 
Logger Pro is set up to read the pulse time between the photogates and calculate the launch 
speed of the ball.  

6. Connect the hand pump to the Projectile Launcher. Set the release pressure by adjusting the 
range knob. Turn clockwise for higher pressure and higher launch speed and counter-
clockwise for lower pressure and lower launch speed.  

 Note: Ask your instructor how to select an appropriate release pressure. When you pump the 
hand pump, you will hear a small release sound when the pressure is reached. Keep pumping 
until you hear at least three small release sounds, and then wait for five seconds so that the 
pressure is stabilized. Do not adjust the release pressure for the remainder of the activity or 
your prediction will be incorrect. 

 
PROCEDURE 
1. Obtain and wear goggles. 

2. Insert a steel ball into the barrel. To do this, insert the ball into the launch chamber with your 
index finger and guide the ball into the barrel.  

3. Pump the hand pump until the pressure stabilizes. Keep pumping until you hear at least three 
small release sounds and then wait for five seconds so that the pressure is fully stabilized. 

4. Collect data using the following steps. 
a. Click  to start data collection. 
b. Hold the box in front of the opening of the launch chamber so you can catch the ball 

immediately after it leaves the Projectile Launcher. Do not let the ball strike the floor. This 
is important so as not to spoil the prediction. 

c. When you are ready to launch the ball, press and hold the Arm button, and then press the 
Launch button. 

d. Record the speed in the data table. 
 
5. Repeat this process, catching the ball each time, so that you have a total of 10 launch speed 

measurements. Record the values in Table 1. 

6. Inspect your speed data. Calculate the average speed value and identify the maximum and 
minimum values. Record the values in Table 2. 

7. Determine the launch height. 
a. Measure the distance from the tabletop to the floor.  
b. The launch chamber of the Projectile Launcher is 0.146 m above the surface of the table. 

Determine the total distance the ball will fall. 
c. Record this total value as the launch height, h, in Table 2.  
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8. Identify the floor origin and table offset. 
a. The launch point is clearly 

marked on the Projectile 
Launcher. Position the Projectile 
Launcher so that you can 
determine the distance from the 
launch point to the edge of the 
table, in line with the launch 
barrel. You will need this offset 
distance for later calculations. 
Record the offset value in 
Table 2. 

b. Use a plumb bob to locate the 
floor location just below the table 
edge. Mark this point with tape; 
it will serve as your floor origin.  

 
9. Determine the predicted impact 

point range. 
a. Use your average speed value to calculate your prediction for the range, that is, the 

horizontal distance the ball will travel. Record the value in Table 3 as the predicted range 
for the average speed.  

b. Subtract the table offset from the predicted range and record this value in Table 3 as the 
predicted floor distance for the average speed. 

c. To account for the variations you saw in the speed measurements, repeat the calculation 
for the minimum and maximum speed. These two additional points show the limits of 
impact range that you might expect, considering the variation in your speed measurement. 
Record the predicted ranges and floor distances for the maximum and minimum speeds in 
the data table. 

 
 10. Tape a piece of waxed paper to the floor that is long enough to account for the variation you 

have calculated. The waxed paper must be lined up with the launch chamber. 

 11. After your instructor gives you permission, launch the ball and allow it to strike the floor for 
the first time. Measure the distance from the floor origin to the actual impact and enter the 
floor distance in Table 4. Then, calculate the range for the actual impact. 

offset table  distancefloor range +=  
 
 

Figure 3 
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DATA TABLE 

Table 1     

Trial Speed 
(m/s) 

    
 Table 2 

1   Maximum speed  m/s 
2   Minimum speed  m/s 
3   Average speed  m/s 
4   Table height, h  m 
5   Table offset, x0  m 
6      
7       
8      
9      

10      
 

Table 3 

 Predicted range 
(m) 

Predicted floor 
distance  

(m) 

Average speed   

Maximum speed   

Minimum speed   
 

Table 4 

 Floor distance  
(m) 

Range 
(m)  

Actual impact    
 
 
ANALYSIS 
1. Should you expect any numerical prediction based on experimental measurements to be exact? 

Would a range for the prediction be more appropriate? Explain. 

2. Was your actual impact point between your minimum and maximum impact predictions? If so, 
your prediction was successful.  

3. You accounted for variations in the speed measurement in your range prediction. Are there 
other measurements you used which affect the range prediction? What are they? 

4. Did you account for air resistance in your prediction? If so, how? If not, how would air 
resistance change the distance the ball flies? 
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EXTENSIONS 
1. Derive one equation for the horizontal and vertical coordinates of the ball’s motion in this 

experiment. 

2. Investigate different launch angles. 
a. Derive a general formula for projectile motion when the object is launched at an angle. 
b. Predict the impact point based on the launch angle and speed. Repeat the experiment, 

launching the ball at a non-zero angle. Compare the impact point to your prediction. 
Repeat for additional launch angles. 

 
3. Investigate the time of flight of the projectile.  

a. How will the time to strike the floor vary with launch speed? Derive a general formula for 
the time of flight for an object launched horizontally. 

b. How will the time to strike the floor vary with angle? Derive a general formula for the time 
of flight for an object launched at an angle. 

c. Use the Time of Flight Pad to collect time of flight data for various launch speeds. Collect 
multiple trials for each speed to estimate the variations in the measurements.  

  
4. Use the Independence of Motion Accessory with the Projectile Launcher to investigate the 

motion of a dropped ball as another is projected horizontally. Examine one or more of the 
following phenomena. 
• Independence of Motion Do the two balls strike the floor simultaneously, even for 

different horizontal speeds or for differing horizontal distances travelled? Change the 
horizontal speed by changing the air pressure. 

• Independence of Motion and Mass Does the simultaneity depend on the mass of the 
balls? Try the experiment with the plastic balls. 

• Vertical Fall Variation Do the two balls strike the floor simultaneously, even if the drop 
height is much larger? 

• Vertical Speed Variation Set the Launcher barrel to an upward angle of about 20 degrees. 
Do the two balls now strike the floor simultaneously? Why or why not? 
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Projectile Motion 
You have probably watched a ball roll off a table and strike the floor. What determines where it 
will land? Could you predict where it will land? In this experiment, you will use a projectile 
launcher to fire a ball horizontally. A pair of photogates in the launcher will help you measure the 
initial speed. You will use this information and your knowledge of physics to predict where the 
ball will land when it hits the floor. 

 
Figure 1 

 
 
OBJECTIVES 

• Measure the launch speed of a ball using a Vernier Projectile Launcher. 
• Apply concepts from two-dimensional kinematics to predict the impact point of a ball in 

projectile motion. 
• Take into account trial-to-trial variations in the speed measurement when calculating the 

impact point. 
 
 
MATERIALS 

LabQuest meter stick or metric measuring tape 
LabQuest App tape 
Vernier Projectile Launcher level 
goggles Time of Flight Pad (optional, for Extension 
steel ball    only) 
plumb bob Independence of Motion Accessory (optional, 
small cardboard box    for Extension only) 
waxed paper  
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PRELIMINARY QUESTIONS 
Balance one penny on the edge of a table. Place your index finger on a second penny, then flick 
the second penny so that it travels off the table, while the first penny is gently nudged off the 
edge. It may take a few practice trials to be able to do this effectively. 

 
Figure 2 

 
1. Predict which penny will land first, the penny moving horizontally, or the one that simply 

drops off the table. Explain. 

2. Perform the investigation, listening for the sound of the pennies as they land. Was your 
prediction supported or refuted? 

3. You may believe the pennies landed just a little bit apart from each other. Try it a few more 
times. Does one always land before the other? 

4. What will happen if you increase the speed of the second penny? Predict and then give it a try. 

5. What if you increase the height from which the pennies are dropped? Your instructor may 
choose to stack two tables for you to test this. 

6. Based on your observations, does the horizontal speed of the flicked penny affect the impact 
times of the pennies? 

7. What can you then say about the time to hit the floor for each penny?  

 
INITIAL SET UP 
1. Position the launcher next to the edge of your table. Eventually you will fire a ball horizontally 

that will travel several meters, so plan for this when choosing a location.  

2. Place the level on top of the launch chamber. Use the lower knob on the back of the unit to 
adjust the orientation of the launch chamber until level. Tighten the knob to maintain this 
position. 

3. Next, use the upper knob on the back of the launcher to set the scale to 0˚. Move the scale so 
that the notch of the launcher chamber is at 0˚. This setting accounts for deviation of the 
tabletop from horizontal.  

4. Connect the Projectile Launcher to the LabQuest. To do this, connect the clear, telephone-
style end of the cable to the “Interface” port on the Projectile Launcher and the white, 
rectangular British Telecom end to the digital (DIG) port of the LabQuest.  
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5. Choose New from the File menu. During data collection, LabQuest is configured to read the 
pulse time between the photogates and calculate the launch speed of the ball.  

6. Connect the hand pump to the Projectile Launcher. Set the release pressure by adjusting the 
range knob. Turn clockwise for higher pressure and higher launch speed and counter-
clockwise for lower pressure and lower launch speed.  

 Note: Ask your instructor how to select an appropriate release pressure. When you pump the 
hand pump, you will hear a small release sound when the pressure is reached. Keep pumping 
until you hear at least three small release sounds, and then wait for five seconds so that the 
pressure is stabilized. Do not adjust the release pressure for the remainder of the activity or 
your prediction will be incorrect. 

 
PROCEDURE 
1. Obtain and wear goggles. 

2. Insert a steel ball into the barrel. To do this, insert the ball into the launch chamber with your 
index finger and guide the ball into the barrel.  

3. Pump the hand pump until the pressure stabilizes. Keep pumping until you hear at least three 
small release sounds and then wait for five seconds so that the pressure is stabilized. 

4. Collect data using the following steps. 
a. Start data collection. 
b. Hold the box in front of the opening of the launch chamber so you can catch the ball 

immediately after it leaves the Projectile Launcher. Do not let the ball strike the floor. This 
is important so as not to spoil the prediction. 

c. When you are ready to launch the ball, press and hold the Arm button, and then press the 
Launch button. 

d. Tap the Table tab. Record the speed in the data table. 
 
5. Repeat this process, catching the ball each time, so that you have a total of 10 launch speed 

measurements. Record the values in Table 1. 

6. Inspect your speed data. Calculate the average speed value and identify the maximum and 
minimum values. Record the values in Table 2. 

7. Determine the launch height. 
a. Measure the distance from the tabletop to the floor.  
b. The launch chamber of the Projectile Launcher is 0.146 m above the surface of the table. 

Determine the total distance the ball will fall. 
c. Record this total value as the launch height, h, in Table 2.  
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8. Identify the floor origin and table offset. 
a. The launch point is clearly 

marked on the Projectile 
Launcher. Position the Projectile 
Launcher so that you can 
determine the distance from the 
launch point to the edge of the 
table, in line with the launch 
barrel. You will need this offset 
distance for later calculations. 
Record the offset value in 
Table 2. 

b. Use a plumb bob to locate the 
floor location just below the table 
edge. Mark this point with tape; 
it will serve as your floor origin.  

 
9. Determine the predicted impact 

point range. 
a. Use your average speed value to calculate your prediction for the range, that is, the 

horizontal distance the ball will travel. Record the value in Table 3 as the predicted range 
for the average speed.  

b. Subtract the table offset from the predicted range and record this value in Table 3 as the 
predicted floor distance for the average speed. 

c. To account for the variations you saw in the speed measurements, repeat the calculation 
for the minimum and maximum speed. These two additional points show the limits of 
impact range that you might expect, considering the variation in your speed measurement. 
Record the predicted ranges and floor distances for the maximum and minimum speeds in 
the data table. 

 
 10. Tape a piece of waxed paper to the floor that is long enough to account for the variation you 

have calculated. The waxed paper must be lined up with the launch chamber. 

 11. After your instructor gives you permission, launch the ball and allow it to strike the floor for 
the first time. Measure the distance from the floor origin to the actual impact and enter the 
floor distance in Table 4. Then, calculate the range for the actual impact. 

offset table  distancefloor range +=  
  

Figure 3 
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DATA TABLE 

Table 1     

Trial Speed 
(m/s) 

    
 Table 2 

1   Maximum speed  m/s 
2   Minimum speed  m/s 
3   Average speed  m/s 
4   Table height, h  m 
5   Table offset, x0  m 
6      
7       
8      
9      

10      
 

Table 3 

 Predicted range 
(m) 

Predicted floor 
distance  

(m) 

Average speed   

Maximum speed   

Minimum speed   
 

Table 4 

 Floor distance  
(m) 

Range 
(m)  

Actual impact    
 
 
ANALYSIS 
1. Should you expect any numerical prediction based on experimental measurements to be exact? 

Would a range for the prediction be more appropriate? Explain. 

2. Was your actual impact point between your minimum and maximum impact predictions? If so, 
your prediction was successful.  

3. You accounted for variations in the speed measurement in your range prediction. Are there 
other measurements you used which affect the range prediction? What are they? 

4. Did you account for air resistance in your prediction? If so, how? If not, how would air 
resistance change the distance the ball flies? 
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EXTENSIONS 
1. Derive one equation for the horizontal and vertical coordinates of the ball’s motion in this 

experiment. 

2. Investigate different launch angles. 
a. Derive a general formula for projectile motion when the object is launched at an angle. 
b. Predict the impact point based on the launch angle and speed. Repeat the experiment, 

launching the ball at a non-zero angle. Compare the impact point to your prediction. 
Repeat for additional launch angles. 

 
3. Investigate the time of flight of the projectile.  

a. How will the time to strike the floor vary with launch speed? Derive a general formula for 
the time of flight for an object launched horizontally. 

b. How will the time to strike the floor vary with angle? Derive a general formula for the time 
of flight for an object launched at an angle. 

c. Use the Time of Flight Pad to collect time of flight data for various launch speeds. Collect 
multiple trials for each speed to estimate the variations in the measurements.  

  
4. Use the Independence of Motion Accessory with the Projectile Launcher to investigate the 

motion of a dropped ball as another is projected horizontally. Examine one or more of the 
following phenomena. 
• Independence of Motion Do the two balls strike the floor simultaneously, even for 

different horizontal speeds or for differing horizontal distances travelled? Change the 
horizontal speed by changing the air pressure. 

• Independence of Motion and Mass Does the simultaneity depend on the mass of the 
balls? Try the experiment with the plastic balls. 

• Vertical Fall Variation Do the two balls strike the floor simultaneously, even if the drop 
height is much larger? 

• Vertical Speed Variation Set the Launcher barrel to an upward angle of about 20 degrees. 
Do the two balls now strike the floor simultaneously? Why or why not? 
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Computer32
Sound Waves and Beats

Sound waves consist of a series of air pressure variations. A Microphone diaphragm records
these variations by moving in response to the pressure changes. The diaphragm motion is then
converted to an electrical signal. Using a Microphone and an interface, you can explore the
properties of common sounds.

The first property you will measure is the period, or the time for one complete cycle of repetition.
Since period is a time measurement, it is usually written as T. The reciprocal of the period (1/T) is
called the frequency, f, the number of complete cycles per second. Frequency is measured in hertz
(Hz). 1 Hz = 1 s–1.

A second property of sound is the amplitude. As the pressure varies, it goes above and below the
average pressure in the room. The maximum variation above or below the pressure mid-point is
called the amplitude. The amplitude of a sound is closely related to its loudness.

In analyzing your data, you will see how well a sine function model fits the data. The
displacement of the particles in the medium carrying a periodic wave can be modeled with a
sinusoidal function. Your textbook may have an expression resembling this one:

In the case of sound, a longitudinal wave, y refers to the change in air pressure that makes up the
wave, A is the amplitude of the wave, and f is the frequency. Time is represented by t, and the
sine function requires a factor of 2π when evaluated in radians.

When two sound waves overlap, air pressure variations will combine. For sound waves, this
combination is additive. We say that sound follows the principle of linear superposition. Beats
are an example of superposition. Two sounds of nearly the same frequency will create a
distinctive variation of sound amplitude, which we call beats.

Figure 1
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OBJECTIVES
l Measure the frequency and period of sound waves from a keyboard.
l Measure the amplitude of sound waves from a keyboard.
l Observe beats between the sounds of two notes from a keyboard.

MATERIALS
computer
Vernier computer interface
Logger Pro
Vernier Microphone
electronic keyboard

PRELIMINARY QUESTIONS
1. Why are instruments tuned before being played as a group? In what different ways do

musicians tune their instruments?

2. Given that sound waves consist of a series of air pressure increases and decreases, what
would happen if an air pressure increase from one sound wave was located at the same place
and time as a pressure decrease from another of the same amplitude?

3. How is it that we can hear all the instruments played by a group of musicians at once? Are
there conditions under which you cannot hear all instruments? Can two sounds add up to
create an experience that seems less intense than either sound on its own?

PROCEDURE
Part I  Simple Waveforms
1. Connect the Microphone to the computer interface.

2. Set your keyboard to produce a flute sound or pure tone.

3. Open the file “32 Sound Waves” in the Physics with Vernier folder. Data are collected for
only 0.05 s in order to be able to display the rapid pressure variations of sound waves. The
vertical axis corresponds to the variation in air pressure and the units are arbitrary.

4. To center the waveform on zero, it is necessary to zero the Microphone channel. With the
room quiet, click to center waveforms on the time axis.

5. Press and hold a key on the keyboard. Hold the Microphone close to the speaker and click
. The data should be sinusoidal in form, similar to Figure 1.

6. Note the appearance of the graph. Count and record the number of complete cycles shown
after the first peak in your data.
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7. Click Examine, . Click and drag the mouse between the first and last peaks of the
waveform. Read the time interval Δt, and divide it by the number of cycles to determine the
period of the waveform.

8. Calculate the frequency of the note in Hz and record it in your data table.

9. In a similar manner, determine amplitude of the waveform. Click and drag the mouse across
the graph from top to bottom for an adjacent peak and trough. Read the difference in y values,
shown on the graph as Δy.

10. Calculate the amplitude of the wave by taking half of the difference, Δy. Record the value in
your data table.

11. Make a sketch of your graph or print the graph.

12. Save your data by choosing Store Latest Run from the Experiment menu.

13. Fit the function, y = A * sin(B*t + C) + D, to your data. A, B, C, and D are parameters
(numbers) that Logger Pro reports after a fit. This function is more complicated than the
textbook model, but the basic sinusoidal form is the same. Comparing terms, listing the
textbook model’s terms first, the amplitude A corresponds to the fit term A, and 2π f
corresponds to the parameter B. The time is represented by t, Logger Pro’s horizontal axis.
The new parameters C and D shift the fitted function left-right and up-down, respectively,
and are necessary to obtain a good fit. Only the values of parameters A and B are important
to this experiment. In particular, the numeric value of B allows you to find the frequency f
using B = 2π f.
a. Choose Model from the Analyze menu.
b. In the dialog box, choose Run 1|Sound Pressure and click .
c. Select “A*sin(B*t +C) + D (Sine)” from the list of equations.
d. Enter your estimate for the value of A, the amplitude.
e. Enter your estimate for the value of B (start with 2πf).
f. Initially use zero for C and D.
g. Click to view the model with your data.
h. The model and its parameters appear in a box on the graph. Adjust the values until you

have a good fit. Then, record the parameters A, B, C, and D in your data table.

14. Hide the run by choosing Hide Data Set from the Data menu and selecting Run 1 to hide.
Then, repeat Steps 5–13 for an adjacent key on the keyboard. When repeating Step 13(b),
choose Run 2|Sound Pressure. When you are finished analyzing the second frequency, hide
the Run 2 data.

15. Answer the Analysis questions for Part I before proceeding to Part II.
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Part II  Beats
16. Two pure tones with different frequencies sounded at once will create the phenomenon

known as beats. Sometimes the waves will reinforce one another and other times they will
combine to a reduced intensity. This happens on a regular basis because of the fixed
frequency of each tone. To observe beats, simultaneously hold down the two adjacent keys
on the keyboard that you used earlier and listen for the combined sound. If the beats are slow
enough, you should be able to hear a variation in intensity. When the beats are too rapid to be
audible as intensity variations, a single rough-sounding tone is heard. At even greater
frequency differences, two separate tones may be heard, as well as various difference tones.

17. Collect data while the two tones are sounding. You should see a time variation of the sound
amplitude. When you get a clear waveform, choose Store Latest Run from the Experiment
menu. The beat waveform will be stored as Run 3.

18. The pattern will be complex, with a slower variation of amplitude on top of a more rapid
variation. Ignoring the more rapid variation and concentrating in the overall pattern, count the
number of amplitude maxima after the first maximum and record it in the data table.

19. Click Examine, . As you did before, find the time interval for several complete beats.
Divide the difference, Δt, by the number of cycles to determine the period of beats (in
seconds). Calculate the beat frequency in Hz from the beat period. Record these values in
your data table.

20. Proceed to the Analysis questions for Part II.

ANALYSIS
Part I  Simple Waveforms
1. Did your model fit the waveform well? In what ways was the model similar to the data and in

what ways was it different?

2. Since the model parameter B corresponds to 2π f (i.e., f = B/(2π)), use your fitted model to
determine the frequency. Enter the value in your data table. Compare this frequency to the
frequency calculated earlier. Which would you expect to be more accurate? Why?

3. Compare the parameter A to the amplitude of the waveform.

Part II  Beats
4. How is the beat frequency that you measured related to the two individual frequencies?

Compare your conclusion with information given in your textbook.
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DATA TABLE
Part I  Simple Waveforms

Note Number of
cycles

Δt
(s)

Period
(s)

Calculated
frequency

(Hz)

Note Amplitude
(V)

Note Parameter A
(V)

Parameter B
(s–1)

Parameter C Parameter D
(V)

f = B/2π
(Hz)

Part II  Beats

Number of
cycles

Δt
(s)

Period
(s)

Calculated beat
frequency

(Hz)

EXTENSIONS
1. The beats you observed in Run 3 resulted from the overlap of sound waves from the two

notes. How would the data you recorded compare to a simple addition of the waveforms from
the notes individually? If the sound waves combined in air by linear addition, then the
algebraic sum of the data of the individual waveforms should be similar to data of the beats.
The following steps will help you perform the addition:
a. Show Run 3 only (the waveform of the actual beats).
b. Choose New Calculated Column from the Data menu. Give the column the name of

“Sum.”
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c. Click once in the equation field to place the cursor there. Select Choose Specific
Column… from the Variables (Columns) menu. Select “Run1|Sound Pressure,” then
click and type the addition symbol “+.” Next, select Choose Specific Column…
from the Variables (Columns) menu, select “Run 2|Sound Pressure” and click .
The resulting equation will read “Run 1|Sound Pressure”+ “Run 2|Sound Pressure.”

d. Click .
e. A new column, representing the sum of the two waveforms, will be created in each Data

Set.
f. Click on the y-axis label to show the y-axis selection dialog and choose Sum. Click

. You now see the mathematical sum of the Runs 1 and 2. Rescale the graph if
needed. Now use the y-axis label dialog to display only the actual data of the beats. If you
wish to view the sum simultaneously with the collected data, choose “More…” from the
y-axis dialog and then select to display both runs. How is the sum similar to the real data?
How are they different? Do the graphs support the model of additive sound wave
superposition? What if the superposition rule were multiplicative? Would that change the
graph?

2. There are commercial products available called active noise cancellers, which consist of a set
of headphones, microphones, and some electronics. Intended for wearing in noisy
environments where the user must still be able to hear (for example, radio communications),
the headphones reduce noise far beyond the simple acoustic isolation of the headphones.
How might such a product work?

3. The trigonometric identity

is useful in modeling beats. Show how the beat frequency you measured above can be
predicted using two sinusoidal waves of frequency f1 and f2, whose pressure variations are
described by sin(2π f1 t) and sin(2π f2 t).

4. Most of the attention in beats is paid to the overall intensity pattern that we hear. Use the
analysis tools to determine the frequency of the variation that lies inside the pattern (the one
inside the envelope). How is this frequency related to the individual frequencies that
generated the beats?

5. Examine the pattern you get when you play two adjacent notes on a keyboard. How does this
change as the two notes played get further and further apart? How does it stay the same?
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LabQuest32
Sound Waves and Beats

Sound waves consist of a series of air pressure variations. A Microphone diaphragm records
these variations by moving in response to the pressure changes. The diaphragm motion is then
converted to an electrical signal. Using a Microphone and an interface, you can explore the
properties of common sounds.

The first property you will measure is the period, or the time for one complete cycle of repetition.
Since period is a time measurement, it is usually written as T. The reciprocal of the period (1/T) is
called the frequency, f, the number of complete cycles per second. Frequency is measured in hertz
(Hz). 1 Hz = 1 s–1.

A second property of sound is the amplitude. As the pressure varies, it goes above and below the
average pressure in the room. The maximum variation above or below the pressure mid-point is
called the amplitude. The amplitude of a sound is closely related to its loudness.

In analyzing your data, you will see how well a sine function model fits the data. The
displacement of the particles in the medium carrying a periodic wave can be modeled with a
sinusoidal function. Your textbook may have an expression resembling this one:

In the case of sound, a longitudinal wave, y refers to the change in air pressure that makes up the
wave, A is the amplitude of the wave, and f is the frequency. Time is represented by t, and the
sine function requires a factor of 2π when evaluated in radians.

When two sound waves overlap, air pressure variations will combine. For sound waves, this
combination is additive. We say that sound follows the principle of linear superposition. Beats
are an example of superposition. Two sounds of nearly the same frequency will create a
distinctive variation of sound amplitude, which we call beats.

Figure 1
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OBJECTIVES
l Measure the frequency and period of sound waves from a keyboard.
l Measure the amplitude of sound waves from a keyboard.
l Observe beats between the sounds of two notes from a keyboard.

MATERIALS
LabQuest
LabQuest App
Vernier Microphone
electronic keyboard

PRELIMINARY QUESTIONS
1. Why are instruments tuned before being played as a group? In what different ways do

musicians tune their instruments?

2. Given that sound waves consist of a series of air pressure increases and decreases, what
would happen if an air pressure increase from one sound wave was located at the same place
and time as a pressure decrease from another of the same amplitude?

3. How is it that we can hear all the instruments played by a group of musicians at once? Are
there conditions under which you cannot hear all instruments? Can two sounds add up to
create an experience that seems less intense than either sound on its own?

PROCEDURE
Part I  Simple Waveforms
1. Connect the Microphone to LabQuest and choose New from the File menu. Data are

collected for only 0.03 s in order to be able to display the rapid pressure variations of sound
waves.

2. To center the waveform on zero, it is necessary to zero the Microphone channel. With the
room quiet, choose Zero from the Sensors menu.

3. Press and hold a key on the keyboard. Hold the Microphone close to the speaker and start
data collection. When data collection is complete, a graph is displayed. The data should be
sinusoidal in form, similar to Figure 1.

4. Print or make a sketch of your graph.

5. To examine the data pairs on the displayed graph, tap any data point. As you tap each data
point, sound and time values will be displayed to the right of the graph. Record the times for
the first and last peaks of the waveform. Record the number of complete cycles that occur
between your first measured time and the last. Divide the difference, Δt, by the number of
cycles to determine the period of the note. Record the period in your data table.
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6. Examine the graph again, and record in the data table the maximum and minimum sound
values for an adjacent peak and trough.

7. Calculate the amplitude of the wave by taking half of the difference between the maximum
and minimum y values. Record the values in your data table.

8. Calculate the frequency of the note in Hz and record it in your data table.

9. Model your data.
a. Choose Model from the Analyze menu, then choose Sound Pressure.
b. Select the equation, Asin(Bx + C) + D.

10. To see how well the model fits the data, you need to adjust the parameters of the model y =
Asin(2πf t) and plot it with the data. The model, expressed as Y = A * sin(B*X + C) + D,
contains four parameters; it is more complicated than the textbook model, but the basic
sinusoidal form is the same. Comparing terms, listing the textbook model’s terms first, the
amplitude, A, corresponds to the fit term A, and 2π f corresponds to the parameter B. The
variable X represents the time, t. The new parameters C and D shift the fitted function left-
right and up-down, respectively and may be necessary to obtain a good fit. Only the values of
parameters A and B are important to this experiment. In particular, the numeric value of B
allows you to find the frequency f using B = 2π f.
a. Enter your estimate for the value of A, the amplitude.
b. Enter your estimate for the value of B (start with 2πf).
c. Initially use zero for C and D.
d. LabQuest will plot the data and your model with the current values of A, B, C, and D.

Adjust each value until you see what each one does and until you have a good match of
your model to the data.

e. After optimizing the four values, record the parameters A, B, C, and D in your data table.
Select OK.

11. Repeat Steps 3–10 for an adjacent key on the keyboard.

12. Answer the Analysis questions for Part I before proceeding to Part II.

Part II  Beats
13. Two pure tones with different frequencies sounded at once will create the phenomenon

known as beats. Sometimes the waves will reinforce one another and other times they will
combine to a reduced intensity. This happens on a regular basis because of the fixed
frequency of each tone. To observe beats, simultaneously hold down the two adjacent keys
on the keyboard that you used earlier and listen for the combined sound. If the beats are slow
enough, you should be able to hear a variation in intensity. When the beats are too rapid to be
audible as intensity variations, a single rough-sounding tone is heard. At even greater
frequency differences, two separate tones may be heard, as well as various difference tones.
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14. To capture the beats, it is necessary to collect data for a longer period of time.
a. Tap Meter.
b. On the Meter screen, tap Rate. Change the data-collection rate to 2500 samples/second

and the data-collection duration to 0.05 seconds.
c. Select OK.

15. Start the two tones sounding and start data collection.

16. Note the shape of your waveform graph. You should see a time variation of the sound
amplitude. The pattern will be complex, with a slower variation of amplitude on top of a more
rapid variation. Ignoring the more rapid variation and concentrating in the overall pattern,
count the number of amplitude maxima after the first maximum and record it in the data table.

17. Record the times for the first and last amplitude maxima. To do this, tap any data point.
Divide the difference, Δt, by the number of cycles to determine the period of beats (in
seconds). Calculate the beat frequency in Hz from the beat period. Record these values in
your data table.

ANALYSIS
Part I  Simple Waveforms
1. Did your model fit the waveform well? In what ways was the model similar to the data and in

what ways was it different?

2. Since the model parameter B corresponds to 2π f (i.e., f = B/(2π)), use your fitted model to
determine the frequency. Enter the value in your data table. Compare this frequency to the
frequency calculated earlier. Which would you expect to be more accurate? Why?

3. Compare the parameter A to the amplitude of the waveform.

Part II  Beats
4. How is the beat frequency that you measured related to the two individual frequencies?

Compare your conclusion with information given in your textbook.
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DATA TABLE
Part I  Simple Waveforms

Note Number of
cycles

Time of
first max

(s)

Time of last
max
(s)

Δt
(s)

Period
(s)

Calculated frequency
(Hz)

Note Peak
(V)

Trough
(V)

Amplitude
(V)

Note Parameter A
(V)

Parameter B
(s–1)

Parameter C Parameter D
(V)

f = B/2π
(Hz)

Part II  Beats

Number of
cycles

Time of first
max
(s)

Time of last
max
(s)

Δt
(s)

Beat
(s)

Calculated beat
frequency

(Hz)

EXTENSIONS
1. There are commercial products available called active noise cancellers, which consist of a set

of headphones, microphones, and some electronics. Intended for wearing in noisy
environments where the user must still be able to hear (for example, radio communications),
the headphones reduce noise far beyond the simple acoustic isolation of the headphones.
How might such a product work?

2. The trigonometric identity
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is useful in modeling beats. Show how the beat frequency you measured above can be
predicted using two sinusoidal waves of frequency f1 and f2, whose pressure variations are
described by sin(2π f1 t) and sin(2π f2 t).

3. Most of the attention in beats is paid to the overall intensity pattern that we hear. Use the
analysis tools to determine the frequency of the variation that lies inside the pattern (the one
inside the envelope). How is this frequency related to the individual frequencies that
generated the beats?

4. Examine the pattern you get when you play two adjacent notes on a keyboard. How does this
change as the two notes played get further and further apart? How does it stay the same?
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Conservation of  
Angular Momentum 

INTRODUCTION 
In your study of linear momentum, you learned that, in the absence of an unbalanced external 
force, the momentum of a system remains constant. In this experiment, you will examine how the 
angular momentum of a rotating system responds to changes in the moment of inertia, I. 

OBJECTIVES 
In this experiment, you will 

• Collect angle vs. time and angular velocity vs. time data for rotating systems. 
• Analyze the θ-t and ω-t graphs both before and after changes in the moment of inertia. 
• Determine the effect of changes in the moment of inertia on the angular momentum of the 

system.  
 

MATERIALS 
Vernier data-collection interface ring stand or vertical support rod 
Logger Pro or LabQuest App balance 
Vernier Rotary Motion Sensor metric ruler 
Vernier Rotary Motion Accessory Kit  

 
 
PROCEDURE 
1. Mount the Rotary Motion Sensor to the vertical support rod. Place the 3-step Pulley on the 

rotating shaft of the sensor so that the largest pulley is on top. Measure the mass and diameter 
of the aluminum disk with the smaller hole. Mount this disk to the pulley using the longer 
machine screw sleeve (see Figure 1). 

 
Figure 1 
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2. Connect the sensor to the data-collection interface and begin the 
data-collection program. The default data-collections settings are 
appropriate for this experiment.  

3. Spin the aluminum disk so that it is rotating reasonably rapidly, then 
begin data collection. Note that the angular velocity gradually 
decreases during the interval in which you collected data. Consider 
why this occurs. Store this run (Run 1). 

4. Obtain the second aluminum disk from the accessory kit; determine 
its mass and diameter. Position this disk (cork pads down) over the 
sleeve of the screw holding the first disk to the pulley. Practice 
dropping the second disk onto the first so as to minimize any torque 
you might apply to the system (see Figure 2). 

5. Begin the first disk rotating rapidly as before and begin collecting 
data. After a few seconds, drop the second disk onto the rotating 
disk and observe the change in both the θ-t and ω-t graphs. Store 
this run (Run 2). 

6. Repeat Step 5, but begin with a lower angular velocity than before. 
Store this run (Run 3). 

7. Find the mass of the steel disk. Measure the diameter of both the 
central hole and the entire disk. Replace the first aluminum disk with 
the steel disk and hub and tighten the screw as before (see Figure 3). 

8. Try to spin the steel disk about as rapidly as you did the aluminum 
disk in Step 3 and then begin collecting data. Store this run (Run 4).  

9. Repeat Step 5, dropping the aluminum disk onto the steel disk after 
a few seconds. Store this run (Run 5) and save the experiment file in 
case you need to return to it. 

 
EVALUATION OF DATA  
1. Use a text or web resource to find an expression for the moment of inertia for a disk; 

determine the values of I for your aluminum disks. With its large central hole, the steel disk 
should be treated as a cylindrical tube. Using the appropriate expression, determine the value 
of I for the steel disk.  

2. Examine the ω-t graph for your runs with the single aluminum disk (Run1) and the steel disk 
(Run 4). Determine the rate of change of the angular velocity, ω, for each disk as it slowed. 
Account for this change in terms of any unbalanced forces that may be acting on the system. 
Explain the difference in the rates of change of ω (aluminum vs. steel) in terms of the values 
you calculated in Step 1. 

Figure 2 

Figure 3 
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3. Examine the ω-t graph for Run 2. Determine the rate of change of ω before you dropped the 
second disk onto the first. Record the angular velocity just before and just after you increased 
the mass of the system. Determine the time interval (∆t) between these two velocity readings. 

• In Logger Pro, drag-select the interval between these two readings. The ∆x in the lower 
left corner gives the value of ∆t. 

• In LabQuest App, drag and select the interval between these two readings and use the 
Delta function under Statistics to perform this task. 

4. The angular momentum, L, of a system undergoing rotation is the product of its moment of 
inertia, I, and the angular velocity, ω. 

 

L = Iω  
 Determine the angular momentum of the system before and after you dropped the second 

aluminum disk onto the first. Calculate the percent difference between these values. 

5. Use the initial rate of change in ω and the time interval between your two readings to 
determine ∆ω due to friction alone. What portion of the difference in the angular momentum 
before and after you increased the mass can be accounted for by frictional losses?  

6.  Repeat the calculations in Steps 3–5 for your third and fifth runs. 

 
EXTENSION 
In this experiment, the moment of inertia of the rotating system was changed by adding mass. In 
what other way could one change the moment of inertia? Consider an example of how this is done 
outside the lab. Explain how this change in I produces a change in ω . 
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Impulse and Momentum 
The impulse-momentum theorem relates impulse, the average force applied to an object times the 
length of time the force is applied, and the change in momentum of the object: 

if mvmvtF −=∆  

Here, we will only consider motion and forces along a single line. The average force, F , is the net 
force on the object, but in the case where one force dominates all others, it is sufficient to use only 
the large force in calculations and analysis. 

For this experiment, a Motion Encoder Cart will roll along a level track. Its momentum will 
change as it collides with a hoop spring. The hoop will compress and apply an increasing force 
until the cart stops. The cart then changes direction and the hoop expands back to its original 
shape. The force applied by the spring is measured by a Dual-Range Force Sensor. The cart 
velocity throughout the motion is measured with a Motion Encoder. You will then use data-
collection software to find the impulse to test the impulse-momentum theorem.  

 
Figure 1 

 
 
OBJECTIVES 

• Measure a cart’s momentum change and compare it to the impulse it receives. 
• Compare average and peak forces in impulses. 

 
 
MATERIALS 

computer Vernier Dual-Range Force Sensor 
Vernier computer interface Vernier Dynamics Track 
Logger Pro  Motion Encoder Cart 
Motion Encoder Receiver Vernier Bumper and Launcher Kit 

 
 
PRELIMINARY QUESTIONS 
1. In a car collision, the driver’s body must change speed from a high value to zero. This is true 

whether or not an airbag is used, so why use an airbag? How does it reduce injuries? 

2. Two playground balls, the type used in the game of dodge ball, are inflated to different levels. 
One is fully inflated and the other is flat. Which one would you rather be hit with? Why? 
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PROCEDURE 
1. Measure the mass of the cart and record the value in the data table. 

2. Attach the Motion Encoder Receiver to one end of the Dynamics Track (see Figure 1). 

3. Set the range switch on the Dual-Range Force Sensor to 10 N. Replace the hook end of the 
Dual-Range Force Sensor with the hoop spring bumper. Attach the Dual-Range Force Sensor 
to the bumper launcher assembly as shown in Figure 2. Then attach the bumper-launcher 
assembly to the end of the track opposite the Motion Encoder Receiver. 

 
Figure 2  Connect the Dual-Range Force Sensor to the bumper-launcher assembly.  
Note: Shown inverted from how the sensor and assembly are attached to the track. 

 
4. Place the track on a level surface. Confirm that the track is level by placing the low-friction 

cart on the track and releasing it from rest. It should not roll. If necessary, adjust the track to 
level it. 

5. Connect the Motion Encoder Receiver to a digital (DIG) port of the interface. Connect the 
Dual-Range Force Sensor to Channel 1 of the interface.  

6. Open the file “19 Impulse and Momentum” in the Physics with Vernier folder. 

7. Remove all force from the Dual-Range Force Sensor. Click , select only the Dual-
Range Force Sensor in the list, and click  to zero the sensor. 

Part I  Elastic collisions 
8. Practice releasing the cart so it rolls toward the hoop spring, bounces gently, and returns to 

your hand. The Dual-Range Force Sensor must not shift, and the cart must stay on the track. 

9. Position the cart so that the front of the cart is approximately 50 cm from the spring. 
Click ; roll the cart so it bounces off the spring. 

 10. Study your graphs to determine if the run was useful. Inspect the force data. If the peak 
exceeds 10 N, then the applied force is too large. Roll the cart with a lower initial speed. 

 11. Once you have made a run with good position, velocity, and force graphs, analyze your data. 
To test the impulse-momentum theorem, you need the velocity before and after the impulse.  
a. On the position vs. time graph, find an interval corresponding to a time before the impulse, 

when the cart was moving at approximately constant speed toward the Dual-Range Force 
Sensor. 

b. Select this interval and click Linear Fit, . Record the slope (the average velocity during 
the interval) as the initial velocity in your data table. 
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c. In the same manner, choose an interval corresponding to a time after the impulse, when the 
cart was moving at approximately constant speed away from the Dual-Range Force 
Sensor. 

d. Select this interval and click Linear Fit, . Record the slope (the average velocity during 
the interval) as the final velocity in your data table. 

 
 12. Calculate the value of the impulse. Use the first method if you have studied calculus and the 

second if you have not. 
Method 1  Calculus version 

  Calculus tells us that the expression for the impulse is equivalent to the integral of the force 
vs. time graph, or  

F t F t dt
t

t

initial

final

∆ = ∫ ( )   

  On the force vs. time graph, drag across the impulse, capturing the entire period when the 
force was non-zero. Find the area under the force vs. time graph by clicking Integral, . 
Record the value of the integral in the impulse column of your data table.  

Method 2  Non-calculus version 
  Calculate the impulse from the average force on your force vs. time graph. The impulse is the 

product of the average (mean) force and the length of time that force was applied, or F t∆ . 
a. Click and drag across the impulse, capturing the entire period when the force was non-

zero. 
b. Find the average value of the force by clicking Statistics, , and record this value in your 

data table. 
c. Also read the duration of the time interval, ∆t, over which your average force is calculated, 

which Logger Pro reports on the graph. Record this value in your data table. 
d. From the average force and time interval, determine the impulse, F t∆ , and record this 

value in your data table. 
 

 13. Repeat Steps 9–12 two more times to collect a total of three trials; record the information in 
your data table. 
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Part II  Inelastic collisions 
 14. Replace the hoop spring bumper with one of the clay holders from the Bumper and Launcher 

Kit. Attach cone-shaped pieces of clay to both the clay holder and to the front of the cart, as 
shown in Figure 3.  

 
Figure 3 

 
 15. Remove all force from the Dual-Range Force Sensor. Click , select Dual-Range Force 

Sensor from the list, and click  to zero the Dual-Range Force Sensor. 

 16. Practice launching the cart with your finger so that when the clay on the front of the cart 
collides with the clay on the Dual-Range Force Sensor, the cart comes to a stop without 
bouncing. 

 17. Position the cart so that the front of the cart is approximately 50 cm from the clay holder on 
the Bumper and Launcher Kit. Click ; roll the cart so that the clay pieces impact one 
another. 

 18. Study your graphs to determine if the run was useful. Inspect the force data. If the peak 
exceeds 10 N, then the applied force is too large. Roll the cart with a lower initial speed. 

 19. Once you have made a run with good position, velocity, and force graphs, analyze your data. 
To test the impulse-momentum theorem, you need the velocity before and after the impulse.  
a. On the position vs. time graph, select an interval corresponding to a time before the impact 

and and click Linear Fit, . Record the slope as the initial velocity in your data table. 
b. In the same manner, select the interval corresponding to a time after the impact and click 

Linear Fit, . Record the slope as the final velocity in your data table. 
 

 20. Calculate the value of the impulse. Similar to Step 12, use the first method if you have studied 
calculus and the second if you have not. 
Method 1  Calculus version 

  On the force vs. time graph, click and drag across the impulse, capturing the entire period 
when the force was non-zero. Find the area under the force vs. time graph by clicking Integral, 

. Record the value of the integral in the impulse column of your data table.  

Method 2  Non-calculus version 
  Calculate the impulse from the average force on your force vs. time graph. 

a. Select the impulse, click Statistics, , and record this value in your data table. 
b. Also record the length of the time interval, ∆t, over which your average force is calculated. 
c. From the average force and time interval, determine the impulse, F t∆ , and record this 

value in your data table. 
 



 Impulse and Momentum 

Physics with Vernier  19 - 5 

 21. Repeat Steps 17–20 two more times to collect a total of three trials; record the information in 
your data table. Note: You will need to reshape the clay pieces before each trial. 

 
DATA TABLE  

Mass of cart  kg 
 

Method 1  Calculus version 

Trial 

Final 
velocity 

vf 
(m/s) 

Initial 
velocity 

vi 
(m/s) 

Change of 
velocity 

∆v  
(m/s) 

Impulse 
(N⋅s) 

Change in 
momentum 
(kg⋅m /s) or 

(N⋅s) 

% difference 
between Impulse 
and Change in 

momentum 

Elastic 1       

2       

3       

Inelastic 1       

2       

3       
 

Method 2  Non-calculus version 

Trial 

Final 
velocity 

vf 
(m/s) 

Initial 
velocity 

vi 
(m/s) 

Change 
of 

velocity   
∆v  

(m/s) 

Average 
force 

F  
(N) 

Duration 
of 

impulse 
∆t 
(s) 

Impulse  
tF∆  

(N⋅s) 

Change in 
momentum 
(kg⋅m /s) or 

 (N⋅s) 

% 
difference 
between 

Impulse and 
Change in 
momentum 

Elastic 1         

2         

3         

Inelastic 1         

2         

3         

 
ANALYSIS 
1. Calculate the change in velocities and record the result in the data table. From the mass of the 

cart and the change in velocity, determine the change in momentum that results from the 
impulse. Make this calculation for each trial and enter the values in the data table. 
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2. If the impulse-momentum theorem is correct, the change in momentum will equal the impulse 
for each trial. Experimental measurement errors, along with friction and shifting of the track 
or Dual-Range Force Sensor, will keep the two from being exactly the same. One way to 
compare the two is to find their percentage difference. Divide the difference between the two 
values by the average of the two, then multiply by 100%. How close are your values, 
percentage-wise? Do your data support the impulse-momentum theorem? 

3. Look at the shape of the last force vs. time graph. Is the peak value of the force significantly 
different from the average force? Is there a way you could deliver the same impulse with a 
much smaller force? 

4. Revisit your answers to the Preliminary Questions in light of your work with the impulse-
momentum theorem. 

 
EXTENSION 
The Bumper and Launcher Kit includes two different hoop springs, with one stiffer than the other. 
Repeat your experiment with the spring you have not yet used. Predict how the results will be 
similar and how they will be different. 
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Impulse and Momentum 
The impulse-momentum theorem relates impulse, the average force applied to an object times the 
length of time the force is applied, and the change in momentum of the object: 

if mvmvtF −=∆  

Here, we will only consider motion and forces along a single line. The average force, F , is the net 
force on the object, but in the case where one force dominates all others, it is sufficient to use only 
the large force in calculations and analysis. 

For this experiment, a Motion Encoder Cart will roll along a level track. Its momentum will 
change as it collides with a hoop spring. The hoop will compress and apply an increasing force 
until the cart stops. The cart then changes direction and the hoop expands back to its original 
shape. The force applied by the spring is measured by a Dual-Range Force Sensor. The cart 
velocity throughout the motion is measured with a Motion Encoder. You will then use data-
collection software to find the impulse to test the impulse-momentum theorem.  

 
Figure 1 

 
 
OBJECTIVES 

• Measure a cart’s momentum change and compare to the impulse it receives. 
• Compare average and peak forces in impulses. 

 
 
MATERIALS 

LabQuest Vernier Bumper and Launcher Kit 
LabQuest App Vernier Motion Encoder Cart  
Vernier Motion Encoder Receiver Vernier Dynamics Track 
Vernier Dual-Range Force Sensor  

 
 
PRELIMINARY QUESTIONS 
1. In a car collision, the driver’s body must change speed from a high value to zero. This is true 

whether or not an airbag is used, so why use an airbag? How does it reduce injuries? 

2. Two playground balls, the type used in the game of dodgeball, are inflated to different levels. 
One is fully inflated and the other is flat. Which one would you rather be hit with? Why? 
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PROCEDURE 
1. Measure the mass of the cart and record the value in the data table. 

2. Attach the Motion Encoder Receiver to one end of the Dynamics Track (see Figure 1). 

3. Set the range switch on the Dual-Range Force Sensor to 10 N. Replace the hook end of the 
Dual-Range Force Sensor with the hoop spring bumper. Attach the Dual-Range Force Sensor 
to the bumper launcher assembly as shown in Figure 2. Then attach the bumper-launcher 
assembly to the end of the track opposite the Motion Encoder Receiver.  

 
Figure 2  Connect the Dual-Range Force Sensor to the bumper-launcher assembly.  
Note: Shown inverted from how the sensor and assembly are attached to the track. 

 
4. Place the track on a level surface. Confirm that the track is level by placing the low-friction 

cart on the track and releasing it from rest. It should not roll. If necessary, adjust the track to 
level it. 

5. Connect the Motion Encoder Receiver to a digital (DIG) port of LabQuest. Connect the Dual-
Range Force Sensor to LabQuest. Turn on the Motion Encoder Cart. Choose New from the 
File menu.  

6. Zero the Dual-Range Force Sensor and then reverse its sign. 
a. Remove all force from the Dual-Range Force Sensor. 
b. Choose Zero ► Force from the Sensors menu.  
c. Choose Reverse ► Force from the Sensors menu to change the sign. Reversing the sign 

sets up the sensor so force readings are positive when there is an impact. 
 
7. Set up the Motion Encoder to “zero on collect” and then reverse its sign. 

a. Tap the Position meter and choose Reset (Zero) on Collect. 
b. Tap the Position meter again and choose Reverse. Changing the sign of the position data 

makes the change in momentum positive when the cart moves away from the Encoder 
Receiver initially. 

8. On the Meter screen, tap Rate. Change the data-collection rate to 250 samples/second and the 
data-collection duration to 5 seconds. Select OK. 

Part I  Elastic collisions 
9. Practice releasing the cart so it rolls toward the hoop spring, bounces gently, and returns to 

your hand. The Dual-Range Force Sensor must not shift, and the cart must stay on the track.  

 10. Position the cart so that the front of the cart is approximately 50 cm from the spring. Start 
data collection, then roll the cart as you practiced in the previous step. 
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 11. Study your graphs to determine if the run was useful. Inspect the force data. If the peak 
exceeds 10 N, then the applied force is too large. Roll the cart with a lower initial speed 

 12. Once you have made a run with good position and force graphs, analyze your data. To test the 
impulse-momentum theorem, you need the velocity before and after the impulse. To find these 
values, work with the graph of position vs. time. 
a. Tap and drag to select an interval corresponding to a time before the impulse, when the 

cart was moving at approximately constant speed toward the Dual-Range Force Sensor.  
b. Choose Curve Fit ► Position from the Analyze menu. Choose a linear fit. Record the 

slope (the average velocity during the interval) as the initial velocity in your data table. 
c. Choose Curve Fit ► Position from the Analyze menu to turn off the curve fit. 
d. Repeat parts a–c of this Step to determine the average velocity for an interval 

corresponding to a time just after the impulse, when the cart was moving at approximately 
constant speed away from the Dual-Range Force Sensor. Record this value as the final 
velocity in your data table. 

 
 13. Calculate the value of the impulse. Use the first method if you have studied calculus and the 

second if you have not. First, zoom in on the impulse to make it easier to analyze. 
a. Tap and drag across a region of the graph that includes the impulse, starting before the 

force becomes non-zero and ending after the force returns to zero. 
b. Choose Zoom In from the Graph menu. 

 
Method 1  Calculus version 

  Calculus tells us that the expression for the impulse is equivalent to the integral of the force 
vs. time graph, or 

F t F t dt
t

t

initial

final

∆ = ∫ ( )   

  Calculate the integral of the impulse on your force vs. time graph. 
a. Tap and drag across the region that represents the impulse (begin at the point where the 

force becomes non-zero). 
b. Choose Integral ► Force from the Analyze menu. 
c. Read the value of the integral of the force data, the impulse value, and record the value in 

the data table. 
 

Method 2  Non-calculus version 
  Calculate the impulse from the average force on your force vs. time graph. The impulse is the 

product of the average (mean) force and the length of time that force was applied, or F t∆ . 
a. Tap and drag across the region that represents the impulse (begin at the point where the 

force becomes non-zero). 
b. Choose Statistics from the Analyze menu. 
c. Record the value for the average (mean) force in the data table. 
d. Read the duration of the time interval. To determine this value, note the number of points 

used in the average (N), and multiply by 0.004 s, the time interval between points. Record 
this product, ∆t, in your data table. 
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e. From the average force and time interval, determine the impulse, F t∆ , and record this 
value in your data table. 

 
 14. Repeat Steps 9–12 two more times to collect a total of three trials; record the information in 

your data table. 

Part II  Inelastic collisions 
 15. Replace the hoop spring bumper with one of the clay holders from the Bumper and Launcher 

Kit. Attach cone-shaped pieces of clay to both the clay holder and to the front of the cart, as 
shown in Figure 3.  

 
Figure 3 

 
 16. Remove all force from the Dual-Range Force Sensor and then choose Zero ► Force from the 

Sensors menu to zero the Dual-Range Force Sensor. 

 17. Practice launching the cart with your finger so that when the clay on the front of the cart 
collides with the clay on the Dual-Range Force Sensor, the cart comes to a stop without 
bouncing. 

 18. Position the cart so that the front of the cart is approximately 50 cm from the spring. Start 
data collection, then roll the cart so that the clay pieces impact one another. 

19. Study your graphs to determine if the run was useful. Inspect the force data. If the peak 
exceeds 10 N, then the applied force is too large. Reshape the clay pieces and roll the cart 
with a lower initial speed. 

 
 20. Once you have made a run with good position and force graphs, analyze your data. To test the 

impulse-momentum theorem, you need the velocity before and after the impulse.  
a. Tap and drag to select an interval corresponding to a time before the impulse, when the 

cart was moving at approximately constant speed toward the Dual-Range Force Sensor.  
b. Choose Curve Fit ► Position from the Analyze menu. Choose a linear fit. Record the 

slope (the average velocity during the interval) as the initial velocity in your data table. 
c. Choose Curve Fit ► Position from the Analyze menu to turn off the curve fit. 
d. Select an interval corresponding to a time just after the impulse. Repeat steps b. and c. to 

determine the slope of the position graph during this interval. Record this value as the final 
velocity in your data table. 

 
 21. Calculate the value of the impulse. Similar to Step 12, use the first method if you have studied 

calculus and the second if you have not. 
Method 1  Calculus version 

  Calculate the integral of the impulse on your force vs. time graph. 
a. Tap and drag across the impulse, then choose Integral ► Force from the Analyze menu. 
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b. Record the impulse value in the data table. 
 

Method 2  Non-calculus version 
  Calculate the impulse from the average force on your force vs. time graph. 

a. Select the impulse, choose Statistics from the Analyze menu and record the average force 
in the data table. 

f. Read the length of the time interval. To determine this value, note the number of points 
used in the average (N), and multiply by 0.004 s, the time interval between points. Record 
this product, ∆t, in your data table. 

g. From the average force and time interval, determine the impulse, F t∆ , and record this 
value in your data table. 

 
 22. Repeat Steps 17–20 two more times to collect a total of three trials; record the information in 

your data table. Note: You will need to reshape the clay pieces before each trial. 

 
DATA TABLE  

Mass of cart  kg 
 

Method 1 (Calculus) 

Trial 

Final 
velocity 

vf 
(m/s) 

Initial 
velocity 

vi 
(m/s) 

Change of 
velocity   

∆v  
(m/s) 

Impulse 
(N⋅s) 

Change in 
momentum 
(kg⋅m /s) or 

(N⋅s) 

% difference 
between Impulse 
and Change in 

momentum 

Elastic 1       

2       

3       

Inelastic 1       

2       

3       
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Method 2 (Non-Calculus) 

Trial 

Final 
velocity 

vf 
(m/s) 

Initial 
velocity 

vi 
(m/s) 

Change 
of 

velocity   
∆v  

(m/s) 

Average 
force 

F  
(N) 

Duration 
of 

impulse 
∆t 
(s) 

Impulse  
tF∆  

(N⋅s) 

Change in 
momentum 
(kg⋅m /s) or 

(N⋅s) 

% 
difference 
between 

Impulse and 
Change in 
momentum 

Elastic 1         

2         

3         

Inelastic 1         

2         

3         
 
ANALYSIS 
1. Calculate the change in velocities and record the result in the data table. From the mass of the 

cart and the change in velocity, determine the change in momentum that results from the 
impulse. Make this calculation for each trial and enter the values in the data table. 

2. If the impulse-momentum theorem is correct, the change in momentum will equal the impulse 
for each trial. Experimental measurement errors, along with friction and shifting of the track 
or Dual-Range Force Sensor, will keep the two from being exactly the same. One way to 
compare the two is to find their percentage difference. Divide the difference between the two 
values by the average of the two, then multiply by 100%. How close are your values, 
percentage-wise? Do your data support the impulse-momentum theorem? 

3. Look at the shape of the last force vs. time graph. Is the peak value of the force significantly 
different from the average force? Is there a way you could deliver the same impulse with a 
much smaller force? 

4. Revisit your answers to the Preliminary Questions in light of your work with the impulse-
momentum theorem. 

 
EXTENSION 
The Bumper and Launcher Kit includes two different hoop springs, with one stiffer than the other. 
Repeat your experiment with the spring you have not yet used. Predict how the results will be 
similar and how they will be different. 
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Distance and Radiation 
Scientists and health care workers using intense radiation sources are often told that the best 
protection is distance; that is, the best way to minimize exposure to radiation is to stay far away 
from the radiation source. Why is that?  

A physically small source of radiation, emitting equally in all directions, is known as a point 
source. By considering the way radiation leaves the source, you will develop a model for the 
intensity of radiation as a function of distance from the source. Your model may help explain 
why users of radiation sources can use distance to reduce their exposure.  

In this experiment you will use a small source of gamma radiation. Gamma rays are high-energy 
photons. If your source behaves as a point source, and if the air absorbs little or none of the 
gamma radiation, then the radiation intensity should be described well by your model. Follow all 
local procedures for handling radioactive materials. 

OBJECTIVES 
 Develop a model for the distance-dependence of gamma radiation emitted from a point 

source. 
 Use a counter to measure radiation emitted by a gamma source as a function of distance. 
 Analyze count rate data in several ways to test for consistency with the model. 

MATERIALS 
computer 
Vernier computer interface 
Logger Pro 
Vernier Radiation Monitor 
cobalt-60 1µC gamma source 
meter stick 

PRELIMINARY QUESTIONS 
1. Place your cobalt-60 source on a table. Connect the Radiation Monitor to a DIG port on your 

interface and start the data-collection software if it doesn't start automatically. The LED on 
the Radiation Monitor flashes as the monitor detects radiation. The LED will flash more 
quickly when the monitor detects higher radiation level. Using this information and the 
cobalt-60 source, determine the most sensitive place on the detector. That is, roughly where 
inside the monitor case is the radiation being detected? 

2. Starting about a meter from your source, slowly move the monitor closer to the source until 
they nearly touch. How does the flash rate vary with distance from the source? Would you 
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say that the flash rate is proportional to distance from the source? Or is it an inverse 
relationship?  

3. Sketch a qualitative graph of the flash rate vs. distance from the source. 

4. Suppose a small radiation source (a point source) is placed at the center of two spheres. The 
spheres are transparent to the radiation. One sphere has a radius r, and the other a radius 2r. 
N particles leave the source each second and travel outward toward the spheres. How does 
the number of particles passing through the inner sphere per unit area compare to the number 
per unit area passing through the outer sphere? Solve this problem by considering the 
following: 
a. How many total particles pass through the first sphere? How many pass through the 

second sphere? 
b. How do the surface areas of the two spheres compare? 

5. From your answer to the previous question, write down an expression for the intensity of 
radiation (number of particles passing through a unit area each second) as a function of 
distance from a point source. Assume that N particles leave the source each second. This 
expression is your model for the way radiation intensity varies with distance. Record your 
model in the data table. 

6. Is your model consistent with the qualitative sketch you drew in Preliminary Question 3? 

PROCEDURE 
1. Connect the Radiation Monitor to a DIG port of the computer interface if it isn't already 

connected. 

2. When your source is far from the Radiation Monitor, the monitor still detects background 
counts from cosmic rays and other sources. You will need to correct for this background by 
determining the average count rate with no source near the monitor. Prepare the computer for 
data collection by opening the file “02a Distance” from the Nuclear Radiation w Vernier 
folder. Move all sources at least 2 m from the Radiation Monitor, and click ; 
Logger Pro will count for ten, 30 second intervals. Wait 5 minutes for data collection to 
complete. 

3. After Logger Pro has finished data collection, click once on the graph to make it active. 
Notice that the number of counts in each interval varies. This is to be expected since 
radioactivity is a random process. Click Stats, , to determine the average number of counts 
in an interval. Record the mean value in the data table. 

4. Prepare the computer for data collection by opening the file “02b Distance” from the Nuclear 
Radiation w Vernier folder of Logger Pro. One graph is displayed: Corrected Radiation 
(counts/int) vs. Distance (m).  

5. Enter your correction for the count rate by modifying a column in the Logger Pro data table. 
To do this, choose Column Options►Corrected Radiation from the Data menu. The Equation 
field will read “Radiation” –0. Change the zero to your average background count rate. For 
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example, if your average rate was 7.3, your equation should read “Radiation” –7.3. Click 
 to complete the modification. 

6. Place the center of the source 6 cm from the monitor screen of the Radiation Monitor.  

7. Click  to begin collecting data. Logger Pro will begin counting the number of gamma 
photons that strike the detector during each 30 second count interval.  

8. After at least 30 seconds have elapsed, click . In the entry field, enter 0.06, which is 
the distance in meters from the detector to the center of the source. Complete your entry by 
clicking . Data collection will now pause for you to adjust the apparatus. 

9. Move the source 0.02 m farther from the source. Click  to collect more data, and wait 
30 seconds. 

10. Click , and enter the new distance of 0.08.  

11. In the same way as before, move the source away an additional 0.02 m, click , wait 
thirty seconds, and click . Enter the distance in meters. Repeat this process until the 
distance is at least 0.24 m or the counts in one 30 second interval drops below ten. 

12. Click  instead of  to end data collection. 

DATA TABLE 
Model expression   

Average background 
counts 

  

ANALYSIS 
1. Inspect your graph. Does the count rate appear to follow your model?  

2. Fit an appropriate function to your data. To do this, click once on the graph to select it, then 
click Curve Fit, . Select an equation that has the same mathematical form as your model 
from the equation list, and then click . A best-fit curve will be displayed on the graph. 
If your data follow the model, the curve should closely match the data. If the curve does not 
match well, try a different fit and click  again. When you are satisfied with the fit, 
record the fit equation and parameters in the data table and click . 

3. Print or sketch your graph.  

4. From the evidence presented in your two graphs, does the gamma radiation emitted by your 
source follow your model? Does the relationship seem to fail at larger or smaller distances? 
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EXTENSIONS 
1. Replot your data using a suitable transformation of the x-coordinate so that the resulting plot 

should be linear if the data follow your model. For example, if your model were an inverse-
cube function, replot the data using the inverse-cube of the distance values for the horizontal 
axis. Do your data follow the model well using this test? 

2. Why were you instructed to place the source no closer than 0.06 m from the detector? Repeat 
the experiment, using distances of 0, 0.02, 0.04… out to 0.24 m. Hint: Is the detector a 
spherical surface?  

3. Use a longer counting interval so that you collect at least 300 counts at 0.06 m. Is the 
agreement with the inverse-square relationship any different? Try a much shorter count 
interval. How is the resulting graph different? Why? 

4. Sometimes the table surface can scatter gamma rays, interfering with data collection. Use a 
ring stand or other support to hold the sample above the monitor, so that there are no surfaces 
near the source. Repeat data collection. Do your data agree any better with your model? 
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Distance and Radiation 
Scientists and health care workers using intense radiation sources are often told that the best 
protection is distance; that is, the best way to minimize exposure to radiation is to stay far away 
from the radiation source. Why is that?  

A physically small source of radiation, emitting equally in all directions, is known as a point 
source. By considering the way radiation leaves the source, you will develop a model for the 
intensity of radiation as a function of distance from the source. Your model may help explain 
why users of radiation sources can use distance to reduce their exposure.  

In this experiment you will use a small source of gamma radiation. Gamma rays are high-energy 
photons. If your source behaves as a point source, and if the air absorbs little or none of the 
gamma radiation, then the radiation intensity should be described well by your model. Follow all 
local procedures for handling radioactive materials. 

OBJECTIVES 
 Develop a model for the distance-dependence of gamma radiation emitted from a point 

source. 
 Use a counter to measure radiation emitted by a gamma source as a function of distance. 
 Analyze count rate data in several ways to test for consistency with the model. 

MATERIALS 
LabQuest 
LabQuest App 
Vernier Radiation Monitor 
cobalt-60 1µC gamma source 
meter stick 

PRELIMINARY QUESTIONS 
1. Place your cobalt-60 source on a table. Connect the Radiation Monitor to a DIG port on your 

interface and start the data-collection software if it doesn't start automatically. The LED on 
the Radiation Monitor flashes as the monitor detects radiation. The LED will flash more 
quickly when the monitor detects higher radiation level. Using this information and the 
cobalt-60 source, determine the most sensitive place on the detector. That is, roughly where 
inside the monitor case is the radiation being detected? 

2. Starting about a meter from your source, slowly move the monitor closer to the source until 
they nearly touch. How does the flash rate vary with distance from the source? Would you 
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say that the flash rate is proportional to distance from the source? Or is it an inverse 
relationship?  

3. Sketch a qualitative graph of the flash rate vs. distance from the source. 

4. Suppose a small radiation source (a point source) is placed at the center of two spheres. The 
spheres are transparent to the radiation. One sphere has a radius r, and the other a radius 2r. 
N particles leave the source each second and travel outward toward the spheres. How does 
the number of particles passing through the inner sphere per unit area compare to the number 
per unit area passing through the outer sphere? Solve this problem by considering the 
following: 
a. How many total particles pass through the first sphere? How many pass through the 

second sphere? 
b. How do the surface areas of the two spheres compare? 

5. From your answer to the previous question, write down an expression for the intensity of 
radiation (number of particles passing through a unit area each second) as a function of 
distance from a point source. Assume that N particles leave the source each second. This 
expression is your model for the way radiation intensity varies with distance. Record your 
model in the data table. 

6. Is your model consistent with the qualitative sketch you drew in Preliminary Question 3? 

PROCEDURE 
1. Connect the Radiation Monitor to a DIG port of LabQuest if it isn't already connected. 

Choose New from the File menu.  

2. Set up the data-collection mode. 
a. On the Meter screen, tap Mode. Change the data-collection mode to Events with Entry. 
b. Change the Count Interval to 300 seconds. 
c. Select OK. 

3. When your source is far from the Radiation Monitor, the monitor still detects background 
counts from cosmic rays and other sources. You will need to correct for this background by 
determining the average count rate with no source near the monitor. Determine the 
background count rate.  
a. Move all sources away from the monitor. 
b. Start data collection to prepare the system for data collection.  
c. Tap Keep. Counts are taken for 300 seconds.  
d. Enter 0 to indicate that this is the value for the background count. Select OK. 
e. Stop data collection.  
f. Record the average background counts per minute in your data table. 

4. Set up the data-collection mode. 
a. Tap the Meter tab.  
b. On the Meter screen, tap Mode.  
c. Change the Count Interval to 60 seconds. 
d. Enter the Name (Distance) and the Units (m).  
e. Select OK. 
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5. Place the center of the source 6 cm from the monitor screen of the Radiation Monitor. 

6. Start data collection. Tap Keep. The number of gamma photons that strike the detector will 
be counted during the 60-second data collection period.  

7. After 60 seconds have elapsed, enter 0.06, the distance in meters from the detector to the 
center of the source. Save this data pair by selecting OK. 

8. Move the source 0.02 m farther from the source. Tap Keep to count for the new distance. 
When the data collection period is complete, enter the new distance of 0.08 m and select OK. 

9. In the same way as before, move the source an additional 0.02 m out, tap Keep, and wait for 
counting to complete. Enter the new distance in meters. Repeat this process until the distance 
is at least 0.24 m or the rate drops below 10 counts per minute. 

10. Stop data collection. 

11. Correct the data for background radiation. 
a. Tap the Table tab.  
b. Choose New Calculated Column from the Table menu.  
c. Enter Corrected count as the Name and cpm as the Units.  
d. Select X-A as the Equation.  
e. Enter the average background radiation count from Step 3 as the value for A.  
f. Select OK to view a graph of corrected counts vs. distance. 

DATA TABLE 
Model expression   

Average background 
counts 

  

Fit parameters and 
equation 

  

ANALYSIS 
1. Inspect your graph. Does the count rate appear to follow your model?  

2.  Fit an appropriate function to your data.  
a. On the Graph screen, choose Curve Fit from the Analyze menu. 
b. Choose the equation that matches the mathematical form of your model as the Fit 

Equation. 
c. Record the fit equation and parameters in your data table. 
d. Select OK.  

3. Print or sketch your graph.  
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4. From the evidence presented in your two graphs, does the gamma radiation emitted by your 
source follow your model? Does the relationship seem to fail at larger or smaller distances? 

EXTENSIONS 
1. Replot your data using a suitable transformation of the x-coordinate so that the resulting plot 

should be linear if the data follow your model. For example, if your model were an inverse-
cube function, replot the data using the inverse-cube of the distance values for the horizontal 
axis. Do your data follow the model well using this test? 

2. Why were you instructed to place the source no closer than 0.06 m from the detector? Repeat 
the experiment, using distances of 0, 0.02, 0.04… out to 0.24 m. Hint: Is the detector a 
spherical surface?  

3. Use a longer counting interval so that you collect at least 300 counts at 0.06 m. Is the 
agreement with the inverse-square relationship any different? Try a much shorter count 
interval. How is the resulting graph different? Why? 

4. Sometimes the table surface can scatter gamma rays, interfering with data collection. Use a 
ring stand or other support to hold the sample above the monitor, so that there are no surfaces 
near the source. Repeat data collection. Do your data agree any better with your model? 

5. Instead of using one of the built-in curve fits for your data, choose Model from the Analyze 
menu to superimpose an equation with exactly the same form as your model on your data. 
Does this equation fit your data? Is this a better test of your model? Why? 
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The Magnetic Field in a Slinky 
A solenoid is made by taking a tube and wrapping it with many turns of wire. A metal Slinky is 
the same shape and will serve as a solenoid. When a current passes through the wire, a magnetic 
field is present inside the solenoid. Solenoids are used in electronic circuits or as electromagnets.  

In this lab you will explore factors that affect the magnetic field inside the solenoid and study 
how the field varies in different parts of the solenoid. By inserting a Magnetic Field Sensor 
between the coils of the Slinky, you can measure the magnetic field inside the coil. You will also 
measure μ0, the permeability constant. The permeability constant is a fundamental constant of 
physics. 

 

Figure 1   

OBJECTIVES 
• Determine the relationship between magnetic field and the current in a solenoid. 
• Determine the relationship between magnetic field and the number of turns per meter in a 

solenoid. 
• Study how the field varies inside and outside a solenoid. 
• Determine the value of μ0, the permeability constant. 

MATERIALS 
computer 
Vernier computer interface 
Logger Pro 
Vernier Magnetic Field Sensor 
Extech Digital DC Power Supply 
metal Slinky 
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meter stick 
masking tape 
connecting wires with clips 

INITIAL SETUP 
1. Stretch the Slinky until it is about 1 m long. The spacing between the coils should be 1–2 cm. 

Use a non-conducting material such as masking tape to hold the Slinky at this length. 

2. Set up the circuit and equipment as shown in Figure 1.  

3. Set the range switch on the Magnetic Field Sensor to 0.32 mT (high amplification) and bend 
the tip so it is perpendicular to the sensor. Connect the Magnetic Field Sensor to the 
interface.  

4. Turn on the power supply and adjust it so that the current is 2.0 A. 

5. Open the file “26a Magnetic Field in Slinky” in the Physics with Vernier folder. Use the live 
readout to answer the Preliminary Questions. 

PRELIMINARY QUESTIONS 
1. Hold the Magnetic Field Sensor between the turns of the Slinky with the bent tip at the center 

of the coil (see Figure 2). Rotate the sensor and determine which direction gives the largest 
positive magnetic field reading. What direction is the white dot on the tip of the sensor 
pointing? 

 

Figure 2   

2. What happens if you rotate the sensor so the white dot on the tip points the opposite way? 
What happens if you rotate the sensor so the bent part of the sensor is perpendicular to the 
axis of the solenoid? 

3. Insert the Magnetic Field Sensor through different locations along the Slinky to explore how 
the field varies along the length. Always orient the sensor to read the maximum magnetic 
field at that point along the Slinky. How does the magnetic field inside the solenoid seem to 
vary along its length?  

4. Check the magnetic field intensity just outside the solenoid. Is it different from the field 
inside the solenoid?  
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PROCEDURE 
Part I  How is the Magnetic Field in a Solenoid Related to Current? 

For the first part of the experiment you will determine the relationship between the magnetic 
field at the center of a solenoid and the current flowing through the solenoid. Data will be 
collected in Events with Entry mode. Each time you click  during data collection, data 
will be collected for 10 seconds and then the average value will be displayed. You will then enter 
a value and click  to complete the data point. 

1. Turn off the power supply to stop all current in the solenoid. 

2. Position the Magnetic Field Sensor between the turns of the Slinky near its center, 
lengthwise. Rotate the sensor so that the white dot points directly down the long axis of the 
solenoid in the direction that gives the largest positive magnetic field reading. The bent tip of 
the sensor should still be at the center of the coil, as shown in Figure 2. This will be the 
position for all of the magnetic field measurements for the rest of this part. 

3. With the Magnetic Field Sensor in position, click  to zero the sensor and remove 
readings due to the Earth’s magnetic field, any magnetism in the metal of the Slinky, or the 
table. 

4. Turn on the power supply and adjust the power supply so that it is set to 0.0 A. 

5. Click  to begin data collection.  

6. Click  and hold the sensor still. Enter 0.0 for the current reading. Click  to 
complete the entry. 

7. Increase the current by 0.5 A and repeat Step 6, entering 0.5 as the current reading. 

8. Repeat Step 7 up to a maximum of 2.0 A. 

9. Stop data collection and turn off the power supply. 

10. Answer the Analysis questions for Part I before proceeding to Part II. 

Part II  How is the Magnetic Field in a Solenoid Related to the Spacing of the Turns? 

For the second part of the experiment, you will determine the relationship between the magnetic 
field in the center of a coil and the number of turns of wire per meter of the solenoid. You will 
keep the current constant. Leave the Slinky set up as shown in Figure 1. The sensor will be 
oriented as it was before, so that it measures the field down the middle of the solenoid. You will 
change the length of the Slinky from 0.5 to 2.0 m, in order to change the number of turns per 
meter. 

11. Open the file “26b Magnetic Field in Slinky” in the Physics with Vernier folder. As before, 
data will be collected in Events with Entry mode. 

12. Keep the number of turns the same, but change the length of the slinky to 0.5 m. If you need 
to, re-count the number of turns, and then calculate the number of turns per meter. Record 
these values in the data table. 
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13. With the power supply off and the Magnetic Field Sensor in position, click  to zero the 
sensor and remove readings due to the Earth’s magnetic field, any magnetism in the metal of 
the Slinky, or the table. 

14. Turn on the power supply and adjust the power supply so that it is set to 1.5 A. 

15. Click  to begin data collection.  

16. Click  and hold the Magnetic Field Sensor still. Enter the number of turns per meter 
that you calculated above. Click  to complete the entry. 

17. Change the length of the Slinky to 1.0 m but keep the number of turns the same. As before, 
re-count the number of turns if necessary, and then calculate the number of turns per meter. 
Record the values in the data table. 

18. Repeat Steps 16–17 for lengths of 1.5 m and 2.0 m. Stop data collection when you are 
finished and turn off the power supply. 

19. Proceed to the Analysis questions for Part II. 

ANALYSIS 
Part I  How is the Magnetic Field in a Solenoid Related to Current? 

1. Count the number of turns of the Slinky and measure its length. If you have any unstretched 
part of the Slinky at the ends, do not count it for either the turns or the length. Calculate the 
number of turns per meter of the stretched portion. Record the length, turns, and the number 
of turns per meter in the data table. 

2. Inspect the graph of magnetic field, B, vs. the current, I, through the solenoid. How is 
magnetic field related to the current through the solenoid? 

3. Determine the equation of the best-fit line, including the y-intercept.  

4. Inspect the equation of the best-fit line to the field vs. current data. What are the units of the 
slope? What does the slope measure? 

Part II  How is the Magnetic Field in a Solenoid Related to the Spacing of the Turns? 

5. How is magnetic field related to the coil density, n, measured in turns/meter of the solenoid? 

6. Determine the equation of the best-fit line to your graph. Record the fit parameters and their 
units in your data table.  

7. From Ampere’s law, it can be shown that the magnetic field B inside a long solenoid is  
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where μ0 is the permeability constant. Are your results consistent with this equation? Explain. 

8. Assuming the equation in the previous question applies for your solenoid, calculate the value 
of μ0 using your graph of B vs. n. You will need to convert the slope to units of T•m from 
mT•m. 

9. Look up the value of μ0, the permeability constant. Compare it to your experimental value. 

10. Was your Slinky positioned along an east-west or north-south axis, or was it on some other 
axis? Does this have any effect on your readings? 

DATA TABLE 
Part I 

Length of solenoid (m)   

Number of turns   

Coil density (m–1)   

  

Magnetic field vs. current 

Slope   

Intercept   

Part II 

Number of turns Length of solenoid 
(m) 

Coil density 
(m–1) 
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Magnetic field vs. coil density 

Slope   

Intercept   

EXTENSIONS 
1. Carefully measure the magnetic field at the end of the solenoid. How does it compare to the 

value at the center of the solenoid? Argue what the value at the end should be. 

2. Study the magnetic field strength inside and around a toroid, a circular-shaped solenoid. 

3. If you have studied calculus, refer to a calculus-based physics text to see how the equation 
for the field of a solenoid can be derived from Ampere’s law. 

4. If you look up the permeability constant, you may find it listed in units of henry/meter. Show 
that these units are the same as tesla-meter/ampere. 

5. Take data on the magnetic field intensity vs. position along the length of the solenoid. Check 
the field intensity at several distances along the axis of the Slinky past the end. Note any 
patterns you see. Plot a graph of magnetic field, B, vs. distance from center.  How does the 
value at the end of the solenoid compare to that at the center? How does the value change as 
you move away from the end of the solenoid? 

6. Insert a steel or iron rod inside the solenoid and see what effect that has on the field intensity. 
Be careful that the rod does not short out with the coils of the Slinky. You may need to 
change the range switch setting on the Magnetic Field Sensor. 

7. Use the graph obtained in Part I to determine the value of μ0. 
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The Magnetic Field in a Slinky 
A solenoid is made by taking a tube and wrapping it with many turns of wire. A metal Slinky is 
the same shape and will serve as a solenoid. When a current passes through the wire, a magnetic 
field is present inside the solenoid. Solenoids are used in electronic circuits or as electromagnets.  

In this lab you will explore factors that affect the magnetic field inside the solenoid and study 
how the field varies in different parts of the solenoid. By inserting a Magnetic Field Sensor 
between the coils of the Slinky, you can measure the magnetic field inside the coil. You will also 
measure μ0, the permeability constant. The permeability constant is a fundamental constant of 
physics. 

 

Figure 1   

OBJECTIVES 
• Determine the relationship between magnetic field and the current in a solenoid. 
• Determine the relationship between magnetic field and the number of turns per meter in a 

solenoid. 
• Study how the field varies inside and outside a solenoid. 
• Determine the value of μ0, the permeability constant. 

MATERIALS 
LabQuest 
LabQuest App 
Vernier Magnetic Field Sensor 
Extech Digital DC Power Supply 
metal Slinky 
meter stick 
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masking tape 
connecting wires with clips 
(optional) Logger Pro or graph paper 

INITIAL SETUP 
1. Stretch the Slinky until it is about 1 m long. The spacing between the coils should be 1–2 cm. 

Use a non-conducting material such as masking tape to hold the Slinky at this length. 

2. Set up the circuit and equipment as shown in Figure 1. 

3. Set the range switch on the Magnetic Field Sensor to 0.32 mT (high amplification) and bend 
the tip so it is perpendicular to the sensor. Connect the Magnetic Field Sensor to LabQuest. 
Choose New from the File menu. 

4. Set up the data-collection mode. 

a. On the Meter screen, tap Mode. Change the data-collection mode to Events with Entry. 
b. Enter the Name (Current) and Units (A). 
c. Select Average over 10 seconds. Each time you tap Keep during data collection, data will 

be collected for 10 seconds and then the average value will be displayed. 
d. Select OK. 

5.  Turn on the power supply and adjust it so that the current is 2.0 A. 

PRELIMINARY QUESTIONS 
1. Hold the Magnetic Field Sensor between the turns of the Slinky with the bent tip at the center 

of the coil (see Figure 2). Rotate the sensor and determine which direction gives the largest 
positive magnetic field reading. What direction is the white dot on the tip of the sensor 
pointing? 

 

Figure 2   

2. What happens if you rotate the sensor so the white dot on the tip points the opposite way? 
What happens if you rotate the sensor so the bent part of the sensor is perpendicular to the 
axis of the solenoid? 

3. Insert the Magnetic Field Sensor through different locations along the Slinky to explore how 
the field varies along the length. Always orient the sensor to read the maximum magnetic 
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field at that point along the Slinky. How does the magnetic field inside the solenoid seem to 
vary along its length?  

4. Check the magnetic field intensity just outside the solenoid. Is it different from the field 
inside the solenoid?  

PROCEDURE 
Part I  How is the Magnetic Field in a Solenoid Related to Current? 

For the first part of the experiment you will determine the relationship between the magnetic 
field at the center of a solenoid and the current flowing through the solenoid. Data will be 
collected in Events with Entry mode. Each time you tap Keep during data collection, data will be 
collected for 10 seconds and then the average value will be displayed. You will then enter a 
value and select OK to complete the data point. 

1. Turn off the power supply to stop all current in the solenoid. 

2. Position the Magnetic Field Sensor between the turns of the Slinky near its center, 
lengthwise. Rotate the sensor so that the white dot points directly down the long axis of the 
solenoid in the direction that gives the largest positive magnetic field reading. The bent tip of 
the sensor should still be at the center of the coil, as shown in Figure 2. This will be the 
position for all of the magnetic field measurements for the rest of this part. 

3. To zero the Magnetic Field Sensor to remove readings due to the Earth’s magnetic field, any 
magnetism in the metal of the Slinky, or the table, choose Zero from the Sensors menu. 

4. Now you are ready to collect magnetic field data as a function of current. 

a. Turn on the power supply. 
b. Adjust the power supply so that it is set to 0.0 A. 
c. Start data collection. 
d. Tap Keep and hold the sensor still. Enter 0.0 as the current and select OK to store the data 

pair. 
e. Increase the current by 0.5 A. Tap Keep and enter 0.5 as the current. Select OK. 
f. Repeat this process until you collect data for 2.0 A, and then stop data collection. 

5. Answer the Analysis questions for Part I before proceeding to Part II. 

Part II  How is the Magnetic Field in a Solenoid Related to the Spacing of the Turns? 

For the second part of the experiment, you will determine the relationship between the magnetic 
field in the center of a coil and the number of turns of wire per meter of the solenoid. You will 
keep the current constant. Leave the Slinky set up as shown in Figure 1. The sensor will be 
oriented as it was before, so that it measures the field down the middle of the solenoid. You will 
change the length of the Slinky from 0.5 to 2.0 m, in order to change the number of turns per 
meter. 

6. Change the data-collection mode to create a graph of magnetic field vs. turns per meter. 

a. Choose New from the File menu. 
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b. On the Meter screen, tap Mode. Change the data-collection mode to Events with Entry. 
c. Enter the Name (turns/m) and Units (m-1). 
d. Select Average over 10 seconds. 
e. Select OK. 

7. Keep the number of turns the same, but change the length of the slinky to 0.5 m. If you need 
to, re-count the number of turns, and then calculate the number of turns per meter. Record 
these values in the data table. 

8. With the power supply off and the Magnetic Field Sensor in position, choose Zero from the 
Sensors menu to zero the sensor and remove readings due to the Earth’s magnetic field, any 
magnetism in the metal of the Slinky, or the table. 

9. Collect the first data point. 

a. Turn on the power supply and adjust the power supply so that it is set to 1.5 A. 
b. Start data collection. 
c. Tap Keep and hold the sensor still. Enter the number of turns per meter that you 

calculated above, and select OK to store the data pair. 
10. Collect additional data. 

a. Change the length of the Slinky to 1.0 m but keep the number of turns the same. As 
before, re-count the number of turns if necessary, and then calculate the number of turns 
per meter. Record the values in the data table. 

b. Tap Keep and hold the sensor still. Enter the number of turns per meter that you 
calculated. Select OK. 

c. Repeat this step to collect data for 1.5 m and 2.0 m. 
d. Stop data collection when you have finished with the last point. 
e. Turn off the power supply. 

11.  Proceed to the Analysis questions for Part II. 

ANALYSIS 
Part I  How is the Magnetic Field in a Solenoid Related to Current? 

1. Count the number of turns of the Slinky and measure its length. If you have any unstretched 
part of the Slinky at the ends, do not count it for either the turns or the length. Calculate the 
number of turns per meter of the stretched portion. Record the length, turns, and the number 
of turns per meter in the data table. 

2. Inspect the graph of magnetic field, B, vs. the current, I, through the solenoid. How is 
magnetic field related to the current through the solenoid? 

3. If the points on your graph of magnetic field vs. current through the coils follow a generally 
linear path, fit a straight line to the data. 
a. Choose Curve Fit from the Analyze menu. 
b. Select Linear as the Fit Equation. The linear-regression statistics are displayed. 
c. Record the slope and y-intercept of the regression line in the data table, along with their 

units. 
d. Select OK and print or sketch your graph. 
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4. Inspect the equation of the best-fit line to the field vs. current data. What are the units of the 
slope? What does the slope measure? 

Part II  How is the Magnetic Field in a Solenoid Related to the Spacing of the Turns? 

5. How is magnetic field related to the coil density, n, measured in turns/meter of the solenoid? 

6. If the points on your graph of magnetic field vs. number of turns per meter follow a generally 
linear path, fit a straight line to the data. 

a. Choose Curve Fit from the Analyze menu. 
b. Select Linear as the Fit Equation. The linear-regression statistics are displayed. 
c. Record the slope and y-intercept of the regression line in the data table, along with their 

units. 
d. Select OK and print or sketch your graph. 

7. From Ampere’s law, it can be shown that the magnetic field, B, inside a long solenoid is 
 

where μ0 is the permeability constant. Are your results consistent with this equation? Explain. 

8. Assuming the equation in the previous question applies for your solenoid, calculate the value 
of μ0 using your graph of B vs. n. You will need to convert the slope to units of T•m from 
mT•m. 

9. Look up the value of μ0, the permeability constant. Compare it to your experimental value. 

10. Was your Slinky positioned along an east-west or north-south axis, or was it on some other 
axis? Does this have any effect on your readings? 

DATA TABLE 
Part I 

Length of solenoid (m)   

Number of turns   

Coil density (m–1)   

  

Magnetic field vs. current 

Slope   

Intercept   

Part II 
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Number of turns Length of solenoid 
(m) 

Coil density 
(m–1) 

      

      

      

      

  

Magnetic field vs. coil density 

Slope   

Intercept   

EXTENSIONS 
1. Carefully measure the magnetic field at the end of the solenoid. How does it compare to the 

value at the center of the solenoid? Argue what the value at the end should be. 

2. Study the magnetic field strength inside and around a toroid, a circular-shaped solenoid. 

3. If you have studied calculus, refer to a calculus-based physics text to see how the equation 
for the field of a solenoid can be derived from Ampere’s law. 

4. If you look up the permeability constant, you may find it listed in units of henry/meter. Show 
that these units are the same as tesla-meter/ampere. 

5. Take data on the magnetic field intensity vs. position along the length of the solenoid. Check 
the field intensity at several distances along the axis of the Slinky past the end. Note any 
patterns you see. Plot a graph of magnetic field, B, vs. distance from center. Use Logger Pro 
or graph paper. How does the value at the end of the solenoid compare to that at the center? 
How does the value change as you move away from the end of the solenoid? 

6. Insert a steel or iron rod inside the solenoid and see what effect that has on the field intensity. 
Be careful that the rod does not short out with the coils of the Slinky. You may need to 
change the range switch setting on the Magnetic Field Sensor. 

7. Use the graph obtained in Part I to determine the value of μ0. 
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